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通告

本文档中包含的材料“按原样”提供，在未来版本中如有变更，恕不另行通告。

此外，在相应法律允许的最大范围内，安捷伦科技拒绝对本手册及手册中涉及的任何安捷伦科技

产品提供任何明示或默示保证，包括但不限于适销性及适用于特定用途的默示保证。对本文中的错误

或由于提供、使用或实施本文档或任何相关安捷伦科技产品所导致的间接或直接损失，安捷伦科技概

不负责。如果安捷伦科技与用户签订了书面合同，且任何合同条款与本文相抵触，那么应以合同条款

为准。
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安装指南 ● 安全信息

● 接收仪器

● 环境和电气要求

● 基本设置

● 配件

● 操作检验

● 法规信息

用户指南 ● 仪器概述

● 前面板操作

● 安全

● 基本故障排除

编程指南 ● 远程操作

● 状态寄存器

● 创建和下载文件

SCPI 参考资料 ● SCPI 基础知识

● 命令描述

● 编程命令兼容能力

服务指南 ● 故障排除

● 组件更换

● 可更换的部件

● 维修后程序

● 安全和法规信息

主要帮助信息 a ● 主要功能介绍

● 相关 SCPI 命令

a 按下 Help 硬功能键，然后按下希望获得帮助的键。

文档概述
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信号发生器概述

信号器发生器特点
信号发生器功能

N5181A, 模拟型号: 250 kHz - 1, 3 或 6 GHz

N5182A, 矢量型号: 250 kHz - 3 或 6 GHz

电子衰减器

步进和列表扫描频率, 功率或频率和功率

矢量型号可以包括列表扫描中的波形

用户平坦度校正

自动置平控制 (ALC); 功率校准

10 MHz 参考频率振荡器，带有外部输出

灵活的参考输入, 1 - 50 MHz (选件 1ER)

GPIB, USB 2.0 和 100Base-T LAN 接口

模拟调制: AM, FM 和ΦM (选件 UNT)

外部 AM, FM 和ΦM 输入 (选件 UNT)

脉冲调制 (选件 UNU)

SCPI 和 IVI-COM 驱程

兼容 8648/ESG 代码

满足 LXI Class C 标准

外部模拟 I/Q 输入 (矢量型号)

模拟差分 I/Q 输出 (矢量型号, 选件 1EL)

任意 I/Q 波形播放，速率高达 125 MSa/s (矢量型号, 选件 654)

通过Signal Studio软件，矢量型号可以生成802.11 WLAN, W-CDMA, cdma2000, 1xEV-DO, GSM, EDGE等信号

如需与硬件、固件、软件和存档功能和选件有关的更详细的信息，请参阅信号发生器自带的产品技术资料及

安捷伦科技公司网站:

1. 打开: http://www.agilent.com/find/mxg

2. 选择所需的型号。

3. 在选件和报价单部分，点击 price list。
2 Agilent N5181A/82A MXG 信号发生器用户指南



信号发生器概述

前面板概述
1. 主机 USB 端口 2. 显示屏 3. 软功能键 4. 数字小键盘

5. Arrows and Select
(键盘和选择键)

9. Local
Cancel/(Esc)
(本地取消 /Esc键)

6. Page Up
(上翻页)

8. Trigger
(触发键)

7. MENUS
(菜单键)

10.Help
(帮助键)

11. Preset
and User
Preset
( 预设和用
户预设)

12. RF
Output
(RF输
入键)

13. RF On/Off and LED
(RF 开 / 关和 LED)

14. Mod On/Off and LED
(调制开 / 关和 LED)

17. Q Input
(Q输入键)15. Page Down

(下翻页)

16.I Input
(Ｉ输入键)

18.Knob
(旋钮)

19. Incr Set
(增量设置键)20. Return

(返回键)

21. More and LED
(更多选项键和 LED 指示器)

22. 电源开关和 LED

1. 主机 USB端口

连接器 A 型

USB 协议 2.0

使用这个通用串行总线(USB)连接存储棒，以传送数据。可以在不关闭或重启信号发生器的情况下，连接或

断开 USB 设备。仪器还有一个后面板设备 USB 连接器(参阅 第 11 页 )，用来远程控制仪器。

2. 显示屏

LCD屏幕提供了与当前功能有关的信息，其中可以包括状态指示灯、频率和幅度设置及错误信息。软功能键

标注位于显示屏的右侧。另参阅 第 7 页“前面板显示”。

3. 软功能键

软功能键激活键的左面显示的标注指明的功能。

4. 数字小键盘

数字小键盘包括0-9个硬功能键、一个小数点硬功能键、一个减号硬功能键和一个backspace硬功能键。参阅

第 24 页“输入和编辑数字和文本”。

5. Arrows and Select (键盘和选择键)
Select和箭头硬功能键可以选择信号发生器显示屏上的项目进行编辑。参阅 第24页“输入和编辑数字和文本”。

前面板概述
3Agilent N5181A/82A MXG 信号发生器用户指南



信号发生器概述

前面板概述
6. Page Up (上翻页)

在表格编辑器中，使用这个硬功能键显示上一页。参阅第 25 页“示例: 使用表格编辑器”。当文本在显示区

域中超过一页时，使用这个键和 Page Down 键 ( 第 5 页 )，滚动文本。

7. MENUS (菜单键)
这些硬功能键打开软功能键菜单，可以配置仪器功能或访问信息。

8. Trigger (触发键)

当触发模式设为 Trigger Key 时，这个硬功能键对列表扫描或步进扫描等功能立即引起触发事件。

9. Local Cancel/(Esc) (本地取消 /Esc 键)

这个硬功能键使远程操作无效，把信号发生器返回前面板控制，取消激活的功能项，取消长时间操作(如 IQ

校准)。

10. Help (帮助键)

使用这个键，显示任何硬功能键或软功能键的说明。参阅第 23 页“查看主要说明”。

11. Preset and User Preset (预设和用户预设)

这些硬功能键把信号发生器设置成已知状态(出厂时的状态或用户自定义状态)。参阅第23页“预设信号发生器”。

参阅第 67 页

预留给

将来使用

参阅第 53 页

参阅第 35 页

参阅第 26 页 参阅第 42 页

参阅第 26 页 参阅第 15 页

参阅第 27 页 参阅第23页

只在矢量型号

上激活

参阅第 57 页
参阅第 38 页
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信号发生器概述

前面板概述
12. RF Output (RF 输出键)

连接器 标配: 母头 Type-N

选件 1EM: 后面板母头 Type-N

阻抗: 50 欧姆

损坏电平 50Vdc, 2W 最大 RF 功率

13. RF On/Off and LED (RF 开 /关和 LED)

切换 RF OUTPUT 输出的 RF 信号的工作状态。在打开 RF 输出时，RF On/Off LED 灯亮。

14. Mod On/Off and LED (调制开 / 关和 LED)

允许或禁止调制器调制载波信号。这个硬功能键不会设置或激活一种形式的调制格式(参阅第34页“调制载

波信号”)。

在打开调制输出时，MOD ON/OFF LED 灯亮。

15. Page Down (下翻页)

在表格编辑器中，使用这个硬功能键显示下一页。参阅第 25 页“示例: 使用表格编辑器”。当文本在显示区

域中超过一页时，使用这个键和 Page Up 键 ( 第 4 页 ) 滚动文本。

16. I Input (I 输入键) (仅适用于矢量型号)

连接器 类型: 母头 BNC 阻抗: 50 欧姆

信号 外部提供的 I/Q 调制的模拟同相成分。

对校准后的输出电平，信号电平   I2 + Q2  = 0.5 Vrms。

损坏电平 1Vrms

另参阅第 121 页“I/Q 调制”。

17. Q Input (Q 输入键) (仅适用于矢量型号)

连接器 类型: 母头 BNC 阻抗: 50 欧姆

信号 外部提供的 I/Q 调制的模拟正交相位成分。

对校准后的输出电平，信号电平   I2 + Q2  = 0.5 Vrms。

损坏电平 1Vrms

另参阅第 121 页“I/Q 调制”。
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信号发生器概述

前面板概述
18. Knob (旋钮)

旋转旋钮提高或降低数字值，或把突出显示点移到下一个位、字符或列表项。另参阅第 17 页“前面板旋钮

分辨率”。

19. Incr Set (增量设置键)

这个硬功能键可以设置目前激活的功能的增量值。根据旋钮当前的比率设置(参阅第17页“前面板旋钮分辨率”)，

增量值还影响着每次旋转旋钮改变激活函数值的量。

20. Return (返回键)

这个硬功能键可以返回到以前的按键操作。在一级以上的菜单中，Return 键退回到以前的菜单页面。

21. More and LED (更多选项键和 LED指示器)

在一个菜单中包含的软功能键标注数量超过可以显示的标注数量时， More LED灯亮，在标注下面显示More
信息。如果想显示下一组标注，按下 More 硬功能键。

22. Power Switch and LED (电源开关和 LED)

这个开关选择待机模式或开机模式。在待机位置，黄色 LED 灯亮，所有信号发生器功能无效。信号发生器

保持连接到线路电源上，某些内置电路会消耗部分功率。在开机位置，绿色 LED 灯亮，信号发生器功能激活。
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信号发生器概述

前面板显示
1. 激活功能区域

这个区域显示当前激活的功能。例如, 如果频率是激活的功能，那么会出现当前频率设置。如果当前激活的

功能有一个相关的增量值，那么还会出现这个值。

2. 频率区域

这个区域显示当前频率设置。

3. 指示符

指示符显示部分信号发生器功能的状态，指明错误条件。可以由一个以上的指示符使用一个指示符位置; 在

这种情况下，一次只能激活共享一定位置的多个功能中的一个功能。

指示符 表明...

ΦM 打开相位调制。如果打开频率调制，FM 指示符会代替ΦM。

ARB 打开 ARB 发生器。

ALC OFF 禁用 ALC 电路。如果打开 ALC，不能保持输出电平，那么在同一位置会出现 UNLEVEL 指示符。

AM 打开幅度调制。

ARMED 已经引起扫描，信号发生器等待扫描触发事件。

ATTNHOLD 打开衰减器保持功能。在打开这个功能时，衰减器保持在当前设置。

DETHTR ALC 检测器加热器没有达到温度要求。为满足 ALC 规范，加热器必须达到该温度。

AWGN 打开实时 I/Q 基带附加白高斯噪声。

前面板显示

滚动条

如果显示的文本

内容超过一屏，那么

这里会出现一个滚动

条。使用Page Up和

Page Down 键滚动

文本。

1. 激活功能区域 2. 频率区域 3. 指示符 4. 幅度区域

5. 错误信息区域

6. 文本区域 7. 软功能键标注区域
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信号发生器概述

前面板显示
4. 幅度区域

这个区域显示当前输出功率电平设置。

5. 错误信息区域

这个区域显示缩写的错误信息。如果发生多条信息，那么只会保持显示最新的信息。参阅第 42 页“阅读错

误信息”。

6. 文本区域

这个区域显示信号发生器状态信息(如调制状态)和其它信息(如扫描列表和文件目录)。这个区域还可以执行

信息管理等功能(输入信息，显示或删除文件)。

7. 软功能键标注区域

这个区域显示定义了显示屏右面的软功能键功能的标注。根据选定的功能，软功能键标注会变化。

这个指示符 表明...

DIGBUS 正在使用数字总线。

ERR 错误信息被放在错误队列中。只有在查看所有错误信息或清除错误队列时，才会关闭这个指示符

(参阅第 42 页“阅读错误信息”)。

EXTREF 应用外部频率参考。

FM 打开频率调制。如果打开相位调制，ΦM 指示符会代替 FM。

I/Q 打开 I/Q 矢量调制。

L 信号发生器处于接听方模式，正在通过 GPIB、USB 或 VXI-11/ 插座(LAN)接口接收信息或命令。

MULT 设置频率倍数(参阅第 51 页“设置频率倍数”)。

OFFS 设置输出偏置(参阅第 49 页“设置输出偏置”)。

PULSE 打开脉冲调制。

R 通过 GPIB、USB 或 VXI-11/ 插座(LAN)接口遥控信号发生器。

REF 设置输出参考(参阅第 50 页“设置输出参考”)。

S 信号发生器已经通过 GPIB、USB 或 VXI-11/ 插座(LAN)接口生成服务请求(SRQ)。

SWEEP 信号发生器目前正在列表模式或步进模式下进行扫描。

SWMAN 信号发生器处于手动扫描模式。

T 信号发生器处于发话方模式，正在通过 GPIB、USB 或 VXI-11/ 插座(LAN)接口发送信息。

UNLEVEL 信号发生器不能保持正确的输出电平。这不一定表明仪器发生故障；在正常操作中也可能会发生未调整

电平情况。在禁用 ALC 电路时(参阅上面的 ALC OFF)，在同一位置会出现另一个指示符 ALC OFF。

UNLOCK 任何锁相环不能保持锁相。如果想确定哪个环路失锁，可以查看错误信息(参阅第 42 页“阅读错误信息”)。

WINIT 信号发生器等待引起单次扫描。
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信号发生器概述

后面板概述
1. AC 电源插座

AC电源线插座容纳与信号发生器提供的三叉AC电源线。如需线路设置要求及电源线详情，请参阅安装指南。

2. SWEEP OUT

连接器 母头 BNC 阻抗<1 欧姆

可以驱动 2 千欧。

信号 电压范围: 0 到 +10V, 而不管扫描宽度是多少

在扫描模式下: 扫描开始点 = 0V; 扫描结束点 = +10V

在 CW 模式下: 没有输出

这是多功能连接器。对于输出信号的选择，详情请参阅第 33 页和第 57 页。

3. AM

连接器 母头 BNC 阻抗标称值 50 欧姆

信号 生成指定深度的外部提供的 ± 1Vp 信号。

损坏电平 5Vrms 和 10Vp

后面板概述

数字调制连接器(仅适用于矢量型号)，第 12 页 1. AC 电源插座

仅选件 1EM，

参阅第 5 页

2. SWEEP OUT

3. AM
4. FM

5. PULSE

6. TRIG IN

7. TRIG OUT

8. REF IN

9. 10 MHz OUT

10. GPIB

11. LAN

12.设备USB
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信号发生器概述

后面板概述
4. FM

连接器 母头 BNC 阻抗标称值 50 欧姆

信号 外部提供的生成指定偏差的 ± 1Vp 信号

损坏电平 5Vrms 和 10Vp

5. PULSE

连接器 母头 BNC 阻抗标称值 50 欧姆

信号 外部提供: +1V = on; 0V = off

损坏电平 5Vrms 和 10Vp

6. TRIG IN

连接器 母头 BNC 阻抗高 Z

信号 外部提供的用于触发操作的TTL或CMOS信号，如手动扫描模式下的点到点信号或外部扫描模式

下的 LF 扫描。触发可能发生在正边沿或负边沿。

损坏电平 ≤ -0.5V 和≥ +5.5V

7. TRIG OUT

连接器 母头 BNC 阻抗标称值 50 欧姆

信号 驻留序列开头或在手动扫描模式下等待点触发时为高的 TTL 信号。

在驻留结束或在收到点触发时，信号为低。逻辑极性可以反转。

这是一个多功能连接器。对于输出信号的选择，详情请参阅第 33 页和第 57 页。

8. REF IN

连接器 母头 BNC 阻抗标称值 50 欧姆

信号 从 ± 1 ppm 范围内的时基参考外部提供的 -3.5 到 +20 dBm 信号。

在工厂默认模式下，信号发生器可以在这个连接器上检测有效的参考信号，并自动从外部参考操作切换到外

部参考操作。参阅第 23页“预设信号发生器”。通过选件 1ER (灵活的参考输入)，必须明确告诉信号发生器希望

使用的外部参考频率; 通过前面板或通过远程接口输入信息。
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信号发生器概述

后面板概述
9. 10 MHz OUT
连接器 母头 BNC 阻抗标称值 50 欧姆

信号 标称信号电平大于 4 dBm。

10. GPIB

这个连接器可以与兼容的设备通信，如外部控制器，是为远程控制信号发生器提供的三个连接器中的一个连

接器 (另参阅: 11. LAN 和 12.设备 USB )。

11. LAN

信号发生器通过这个连接器支持基于局域网(LAN)的通信，使得联网的计算机能够远程程控信号发生器。

LAN接口满足LXI Class C标准; 不支持auto-MDIX。信号发生器在一条电缆上支持的最远距离是100米(100Base-

T)。如需与局域网有关的更多信息，请参阅编程指南。

12.设备 USB

连接器 Mini-B

USB 协议 2.0 版

使用这个通用串行总线 (USB) 连接器连接 PC，远程控制信号发生器。
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信号发生器概述

后面板概述
数字调制连接器 (仅适用于矢量型号)

I OUT, Q OUT, I OUT, Q OUT

连接器 类型: 母头 BNC 阻抗: 50 欧姆

DC 耦合

信号

I OUT 来自内置基带发生器的 I/Q 调制的模拟同相成分。

Q OUT 来自内置基带发生器的 I/Q 调制的模拟正交相位成分。

I OUT 与 I OUT 连接器结合使用，提供平衡基带信号源 a。

Q OUT 与 Q OUT 连接器结合使用，提供平衡基带信号源 a。

损坏电平 > 1 Vrms DC 原点偏置         典型值<10 mV

把信号电平输出到 50 欧姆负荷中

·0.5Vpk, 典型值, 与一个单位长度的 I/Q 矢量对应

·0.69Vpk (2.84 dB)，典型值, π /4 DQPSK 峰值, alpha = 0.5 时的最大波峰系数

·0.71Vpk (3.08 dB)，典型值, π /4 DQPSK 峰值, alpha = 0.35 时的最大波峰系数

·典型最大值为 1Vp- p

a 平衡信号是相对于接地对称、但极性相反(失相 180 度)的两条导线中存在的信号。

EXT CLOCK

连接器 母头 BNC 阻抗: 标称值 50 欧姆

信号 外部提供的 TTL 或 CMOS 位时钟信号，其中上升沿与开始数据位对准。

下降沿用来为外部信号提供时钟。

这个信号用于数字调制应用。

损坏电平 > +8 和< -4V 最大时钟速率 50 MHz

EVENT 1

连接器 母头 BNC 阻抗: 标称值 50 欧姆

信号 可以用来触发数据码型、帧或时隙开头的脉冲。可以调节为± 1 个时隙；分辨率 =1 比特位

标识

每个基于Arb的波形点有一个相关的标识开 /关条件。标识1电平= +3.3V CMOS高 (选择了正极);

-3.3V CMOS 低 (选择了负极)。

当基于Arb的波形中标识 1打开时，在这个连接器上会发生输出 (参阅第 82页“使用波形标识”)。

损坏电平 >+8 和<-4V
12 Agilent N5181A/82A MXG 信号发生器用户指南



信号发生器概述

后面板概述
PAT TRIG IN

连接器 母头 BNC 阻抗: 标称值 50 欧姆

信号 TTL/CMOS低到TTL/CMOS高或TTL/CMOS高到TTL/CMOS低边沿触发。这个连接器上的输入

会触发内置数字调制码型发生器，打开单个码型输出或停止和再同步连续输出的码型。为使触发

与数据位时钟同步，触发边沿被闭锁，然后在内部数据位时钟的下降沿期间采样。这是适用于所

有 ARB 波形发生器触发的外部触发。

最小触发输入脉宽(高或低) = 100 ns

最小触发延迟(触发边沿到帧的第一个位) = 1.5 - 2.5 个位时钟周期

损坏电平 > +8 和< -4V

DIGITAL BUS I/O

这是安捷伦科技信号生成软件使用的专有总线。这个连接器不能用于通用用途。只有在安装信号生成软件选

件时才存在信号(详情请参阅 http://www.agilent.com/find/signalcreation)。

AUX I/O

Event 1, 2, 3 和 4 (针脚 1 - 4)
可以用来触发数据码型、帧或时隙开头的脉冲。可以调节为 ± 1 个时隙; 分辨率 =1 比特位

标识

每个基于 Arb 的波形点有一个相关的标识开 / 关条件。标识 1 电平 = +3.3V CMOS 高 (选择了正极); -3.3V CMOS 低(选择了负极)。

当基于 Arb 的波形中相应标识打开时，在这些针脚上会发生输出(参阅第 82 页“使用波形标识”)。

采样速率时钟输出(针脚 5)
这个输出用于内置基带发生器。这个针脚中继 CMOS 位时钟信号，同步串行数据。

损坏电平: > +5.5 和< -0.5V。

Patt Trig In 2 (针脚 6)
TTL/CMOS低到TTL/CMOS高或TTL/CMOS高到TTL/CMOS低边沿触发。这个连接器上的输入会触发内置数字调制码型发生器，打开单个码

型输出或停止和再同步连续输出的码型。

为使触发与数据位时钟同步，触发边沿被闭锁，然后在内部数据位时钟的下降沿期间采样。

这是适用于所有 ARB 波形发生器触发的外部触发。最小脉宽 = 100 ns。损坏电平: > +5.5 和< -0.5V。

针脚 1 = Event 1
针脚 2 = Event 2
针脚 3 = Event 3
针脚 4 = Event 4
针脚 5 = 采样速率时钟输出

针脚 6 = Patt Trig In 2
针脚 7-25 = 预留 *
针脚 26-50 = 接地

*未来功能

后面板母头 50 针连接器内部视图

25

50

1

26
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信号发生器概述

后面板概述



远程操作

配置 GPIB 接口, 第 19 页

配置 LAN 接口, 第 20 页

打开 LAN 服务; 浏览器、套接字和 VXI-11, 第 20 页

2   设置首选项和打开选件

Utility 菜单可以进入用户首选项和远程操作首选项及打开仪器选件的菜单。

第 16 页

第 17 页

打开选件, 第 21 页

升级固件, 第 18 页

用户首选项

前面板旋钮分辨率, 第 17 页

设置时间和日期, 第 18 页
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设置首选项和打开选件

用户首选项
用户首选项

从 Utility 菜单中，可以设置下述用户首选项:

显示设置，参见下面

开机和预设，第 17 页

前面板旋钮分辨率，第 17 页

显示设置

注 在把亮度和对比度设置到最小值时，显示屏可能会太暗而看不清软功能键。如果发生这种情况，

使用上图，找到亮度和对比度软功能键的位置，调节其值，以便能够看清显示屏。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

另参阅“使用安全显示”(仅适用于选件 006)

Utility > Display >
范围: 0-100

范围: 35-55

Light Only: 关闭显示屏灯，在较低的亮度下查看文字。

Light & Text: 关闭显示屏灯和文字。

如果显示屏在长时间内保持不变，使用这一模式，防止文字烧屏。

范围: 1-12 小时，以 1 小时递增

在打开时，通过远程控制总线执行的命

令会相应地更新信号发生器显示屏。

第 137 页

浅色背景上的深色文字

深色背景上的浅色文字

明亮，没有颜色
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设置首选项和打开选件

用户首选项
开机和预设

Utility > Power On/Preset >

恢复永久设置 (不受重新启动、

预设或调用影响)

选择预设后所需的GPIB 语言。

另参阅“编程指南和 SCPI 参考信息”。

只有在8648是选择的预设语言或选择的GPIB远

程语言时才能使用(参阅第 19 页)。

注

为定义用户预设项，根据需要设置仪器，按下 User Preset > Save User Preset。

前面板旋钮分辨率

编制激活项目当前函数的增量值。

Utility >

Instrument Adjustments > 增量值和步长 / 旋钮比决定着每旋转一圈旋钮改变激活函数值的量。

例如，如果激活函数的增量值是 10 dB，步长 /旋钮比是 50:1，那么每

旋转一圈旋钮会把激活函数改变 0.2 dB (10 dB 的 1/50 页)。

为改变每旋转一圈旋钮的量，可以修改增量值、步长 /旋钮比或同时修

改这两个变量。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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设置首选项和打开选件

升级固件
信号发生器的固件追踪时间和日期，使用已经设置为时间 /日期

参考点的最新日期和时间。

设置时间和日期

注意 即使在改变时间或日期时没有安装基于

时间许可，但改变时间或日期仍可能会

给信号发生器使用基于时间许可的能力

带来不利影响。

Utility >
Instrument Adjustments >

向前设置时间或日期

如果向前设置时间或日期，要知道将用完安装的任何基于时间许可，且正在复位信号发生器的时间 /日期参

考点。在设置的新时间或日期比信号发生器当前参考点晚时，该日期成为新的参考点。如果再向后设置时间，那

么会遇到下一节介绍的风险。

向后设置时间或日期

在向后设置时间时，信号发生器会提示时间已经从参考点向后移动(已经设置的最新日期)。如果向后设置的

时间超过大约 25小时，那么会禁用信号发生器使用基于时间的许可，即使在向后设置时间时并没有安装任何许

可。在这种情况下，通过把日期返回参考点前 25小时内，或把日期返回到参考点以后的任何时间，可以重新打

开信号发生器使用基于时间的许可的能力。

原始时间 / 日期参考点 新的时间 / 日期参考点

时间

如果发现向后设置的时间必须超过大约25小时(例如在错误地向前设置时间时)，且希望使用基于时间许可时，

必须与安捷伦科技公司联系，寻求帮助(参阅第 151 页)。

升级固件

如需与新的固件版本有关的信息，请访问网址: http://www.agilent.com/find/upgradeassistant。

当前时间 / 日期参考点

时间

> 25 小时

信号发生器不能再使用

基于时间的许可的点
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设置首选项和打开选件

远程操作首选项
远程操作首选项

如需与远程操作信号发生器有关的详细信息，请参阅编程指南。

参阅下面

第 20 页

第 20 页

注

另外还提供USB，菜单中没有显示，因为它不要求配置。

如需与远程使用仪器有关的详细信息，请参阅编程指南。

配置 GPIB 接口

Utility > I/O Config >

选择所需的 GPIB 语言。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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设置首选项和打开选件

远程操作首选项
配置 LAN接口

Utility > I/O Config >

参阅第 20 页

注

使用100Base-T LAN电缆，把信号发生

器连接到 LAN 上。

使用交叉电缆，把信号发生器直接连接

到 PC 上。

如需与远程使用仪器有关的详细信息，

请参阅编程指南。 编程指南中列明

打开 LAN 服务: 浏览器、套接字和 VXI-11

Utility > I/O Config >

可以远程(浏览器)接入仪器的文件系统。

使用浏览器控制信号发生器。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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设置首选项和打开选件

打开选件
打开选件

可以通过两种方式打开选件:

使用 License Manager 软件辅助工具。

1. 从 www.agilent.com/find/LicenseManager 中下载辅助工具。

2. 运行辅助工具，根据提示进行操作。

使用 SCPI 命令，参阅编程指南。

查看选件和许可

Utility >

Instrument Info >

服务软件许可出现在这里

部分 Signal Studio 软件的波形许可出现在这里
仪器选件出现在这里。

对勾表示打开了选件。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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设置首选项和打开选件

打开选件



Help 硬功能键可以显示任何硬功能键或软功能键说明。为显示帮助信息:

1. 按下Help。

2. 按下所需的键。

显示帮助信息，该键不能正常工作。

预设信号发生器，如下

查看主要说明，如下

输入和编辑数字和文本，第 24 页

设置频率和功率(幅度)，第 26 页

配置扫描输出，第 27 页

调制载波信号，第 34 页

查看、保存和调用数据，第 35 页

阅读错误信息，第 42 页

3   基本操作

本章介绍了基本前面板操作。如需与远程操作有关的信息，参阅编程指南。

预设信号发生器

为把信号发生器返回已知状态，按下 Preset 或 User Preset。

Preset 是出厂预设值; User Preset 是自定义预设值 * (请参阅第 17 页)。

为复位永久设置(预设、用户预设或重新启动不影响这些设置)，

按下: Utility > Power On/Preset > Restore System Defaults。

*通过为每个保存的状态文件分配不同的名称，可以创建一个以上的 User Preset (参阅图 3-6，第 40 页)。

查看主要说明
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基本操作

输入和编辑数字和文本
输入字母字符

数据输入软功能键出现在各种

菜单中。如果其意思在上下文中不

明确，使用帮助键(参阅第 23 页)显

示说明。使用字母表旁边的软功能

键，获得表格帮助。

选择支持字母字符的数据，显

示右面所示的其中一个菜单。

使用箭头键或旋钮，突出显示

所需的字母，然后按下Select硬功

能键 (或字母表旁边的软功能键)。

为校正错误，使用 Bk Sp 或 Clear

Text。

输入和编辑数字和文本

输入数字, 移动光标

使用数字键和小数点，输入数字数据。

上 / 下箭头键会提高 /降低选中的(突出显示的)数字值，并上下移动光标。

Page Up/Down 键会在显示区域内部上下移动数据表。

左 / 右箭头键会左右移动光标。

在输入字母字符时，使用Select硬功能键，选择输入项的一部分。在某些菜单

中，Select 键还作为终结符使用，相当于 Enter 软功能键。

为指定负值，在数字值前面或后面输入

负号(这个键是一个切换键)。

Backspace(退格)会把光标左移，

并删除字符。

注: 旋转旋钮会提高或降低数字值，

改变突出显示的位或字符，或步进通过

列表或一行中的项目。

另参阅前面板旋钮分辨率，第 19 页。如需每个键的详细信息，请参阅第 23 页。

为终止输入，按下 Enter 软功能键。

对十六进制字符，出现这个菜单的子集。字符菜单只显示字母 A 到 F (对其它值，使用数字小键盘)。

注: 文件名称最长为 25 个字符。

为在激活值内部移

动光标，而不是在字

母表内部移动光标，

关闭字母表。

为保存的仪器状态文件

添加 / 编辑注释(参阅第 38 页)。
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基本操作

输入和编辑数字和文本
示例: 使用表格编辑器

表格编辑器简化了配置任务。下面的步骤描述了使用 Lise Mode Values 表格编辑器完成的基本表格编辑器

功能。

1. 预设信号发生器: 按下 Preset。

2. 打开表格编辑器: 按下 Sweep > More > Configure List Sweep。

信号发生器显示编辑器，如下图所示。

3. 突出显示所需的项目: 使用箭头键或旋钮移动光标。

4. (可选) 显示激活功能区域中选中的项目: 按下 Select。

5. 修改取值:

如果取值显示在激活功能区域中，使用旋钮、箭头键或数字小键盘修改取值。

如果取值没有显示在激活功能区域中，使用数字小键盘输入所需的值 (然后其会出现在激活功能区域中)。

6. 结束输入:

如果有相应的单位，按下所需的单位。

如果没有显示单位，按下 Enter (如有) 或 Select。

修改后的项目显示在表格中。

激活功能区域

在编辑时显示激活的项目。

光标

高亮度部分指明了选中的项目。为选中激活的(可以编辑的)项目，

可以按下 Select或输入所需的值。

表格编辑器名称

当前页 /总页数

表格项目

表格项目也称为数据字段。

表格编辑器软功能键

用来加载、导航、修改和存储表格

项目值。如需每个键的详细信息，

使用帮助键: 按下Help硬功能键，

然后按下所需的键。

表明还有

另一个菜单;

为显示第二个

菜单,按下 More。
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基本操作

设置频率和功率 (幅度)
设置频率和功率 (幅度)

图 3-1  频率和幅度软功能键

参阅

第 47 页

仅针对选件

1ER

为显示下一个菜单，按下 More。

第 44 页

示例: 配置 700 MHz, -20 dBm 连续波输出

1. 预设信号发生器。

信号发生器显示最大指定频率和最小功率电平(前面板显示区域如第 7 页所示)。

2. 把频率设置成 700 MHz: 按下 Freq > 700 > MHz。

信号发生器在显示屏的频率区域和激活的项目区域中显示 700 MHz。

3. 把幅度设置成 -20 dBm: 按下 Amptd > -20 > dBm。

显示屏的幅度区域变成 -20 dBm，幅度值变成激活项目。幅度一直是激活功能，直到用户按下另一个功能键。

4. 打开 RF Output: 按下 RF On/Off。

RF Output LED 灯亮，RF OUTPUT 连接器上提供 700 MHz, -20 dBm CW 信号。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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基本操作

配置扫描输出
在频率扫描过程中, 不显示CW频率; 对幅度扫描, 不显示幅度; 对频率和

幅度扫描, 频率和幅度都不显示。

配置扫描输出

信号发生器采用两种方法扫描由频率和幅度点组成的集合:

步进扫描 (第28页) 从选择的一个频率或幅度或频率和幅度中以线性或对数方式前进到另一个频率或幅度或

频率和幅度，在扫描中在线性或对数间隔的点(步进)上暂停。扫描可以向前、向后或手动进行。

列表扫描 (第 29页) 允许以不等的间隔以线性升序、降序或随机顺序输入频率和幅度。列表扫描还允许复制

当前步进扫描值，在扫描中包括 Arb 波形(在矢量仪器上)，把列表扫描数据保存在文件目录中(第 37 页)。

图 3-2 扫描软功能键

如需每个键的详细信息, 使用第 23 页介绍的帮助键。

参阅第 33 页

Down从结束频率 /幅度

扫描到开始频率 / 幅度

Up 从开始频率 / 幅度扫

描到结束频率 / 幅度

不用等待每个点上的触发信号

而进行扫描。在进行第一个扫

描之前，Point Trigger会暂停驻

留时间。

触发远程命令。

对 Trigger In 连接器应用 TTL/
CMOS 信号。

向选择作为来源的设备定期发

出触发事件。

在一次扫描中使用定时器触发

会导致第一次扫描前发生延迟。

参阅

第 33 页

参阅

第 29 页

在 Sweep Type = List时提供

参阅第 28 页

进度条: 超快速扫描可能会表现

为随机扫描或向后扫描。
选择的扫描类型决定着显示的参数。
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基本操作

配置扫描输出
步进扫描

步进扫描从选中的一个频率或幅度或频率和幅度中以线性或对数方式前进到另一个频率或幅度或频率和幅度，

在扫描中在线性或对数间隔的点(步进)上暂停。扫描可以向前、向后或手动进行。

示例: 配置连续的线性步进扫描

输出: 从 500 到 600 MHz 及从 -20 到 0 dBm 连续扫描的信号，在六个等间隔的点中，

每个点上的驻留时间为 500 ms。

1. 预设仪器，打开 Sweep/List 菜单: 按下 Preset > SWEEP。

由于连续扫描是默认的扫描重复选项，线性是默认的步进间隔选项，因此不必设置这些参数。

2. 打开步进扫描菜单: 按下 Configure Step Sweep。

3. 设置下述参数:

开始频率 500 MHz: 按下 Freq Start > 500 > MHz

结束频率 600 MHz: 按下 Freq Stop > 600 > MHz

扫描开始时的幅度, -20 dBm: 按下 Amptd Start > -20 > dBm

扫描结束时的幅度, 0 dBm: 按下 Amptd Stop > 0 > dBm

6 个扫描点: 按下 # Points > 6 > Enter

每个点上的驻留时间, 500 ms: 按下 More > Step Dwell > 500 > msec

4. 同时扫描频率和幅度: 按下 Return > Return > Sweep > Freq Off On > Amptd Off On。

从开始频率 / 幅度到结束频率 / 幅度，连续扫描开始。显示 SWEEP 指示符，CW 频率和幅度显示屏都隐去

(表明正在同时进行频率扫描和幅度扫描)，进度条显示扫描进度。

5. 打开 RF 输出: 按下 RF On/Off。

RF LED 灯亮，RF Output 连接器上提供连续扫描。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

Dwell Time = 信号稳定、在扫描移到下一个点之前

可以进行测量的时间。

(Point-to-point time是为驻留时间设置的值与处理

时间、切换时间和稳定时间之和。)

步进扫描驻留时间和列表扫描驻留时间单独设置。

Lin = 扫描中步进间隔相等; 输出以线性方式变化。

Log = 扫描中步进间隔以对数方式提高; 输出以指数方式变化。
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基本操作

配置扫描输出
列表扫描

列表扫描允许以不等的间隔以线性升序、降序或随机顺序输入频率和幅度。列表扫描还允许复制当前步进扫

描值，在扫描中包括Arb波形(在矢量仪器上)，把列表扫描数据保存在文件目录中(第 37页)。可以在每个点上编

辑驻留时间。

图 3-3 列表扫描配置软功能键和显示屏

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

显示选择的

扫描类型参数

(参阅第 30 页)

参阅第 28 页

只有在矢量型号且在 Sweep Type = List 时才能使用

只有在选择

波形项目时才能使用

每一行定义了扫描中

相应的点。如第1行定

义了第 1 个点

仅适用于矢量型号

参阅第 30 页

参阅第 33 页

选择的扫描决定着信号发生器使用的驻留时间。步进扫描的驻留时间在每个点上相

同; 列表扫描的驻留时间在每个点上可能会不同。

Dwell Time = 信号稳定、在扫描移到下一个点之前可以进行测量的时间。

Point-to-point time是为驻留时间设置的值与处理时间、切换时间和稳定时间之和。
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基本操作

配置扫描输出
示例: 使用步进扫描数据配置列表扫描

1. 设置所需的步进扫描，但不要打开扫描。本例使用第 28 页配置的步进扫描。

2. 在 SWEEP 菜单中，反扫描类型变成列表扫描:

按下 SWEEP > Sweep Type List Step，突出显示 List。

显示屏显示扫描列表参数，如下图所示。

矢量型号:

预设列表会清除以前选择

的任何波形。

如需与选择列表扫描波形

有关的信息，请参阅第31页

“示例: 编辑列表扫描点”

3. 打开 List Sweep 菜单: 按下 More > Configure List Sweep。

4. 从菜单中清除以前设置的任何值，把步进扫描中定义的点加载到列表中:

按下 More > Preset List > Preset with Step Sweep > Confirm Preset。

显示屏更新从步进扫描中加载的值，如下图所示。

5. 扫描频率和幅度: 按下 SWEEP (硬功能键) > Sweep > Freq Off On > Amptd Off On。

设置扫描会打开扫描功能。连续扫描开始。在显示屏上，出现 SWEEP 指示符，进度条显示扫描进度。

6. 如果还没有打开，打开 RF 输出: 按下 RF On/Off。

RF Output LED 灯亮，RF OUTPUT 连接器上提供连续扫描。

只有在矢量型号上

才能使用波形。
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基本操作

配置扫描输出
示例: 编辑列表扫描点

如果不熟悉表格编辑器，参阅第 25 页。

1. 创建所需的列表扫描。本例使用上一个示例中创建的列表扫描。

2. 如果扫描打开，关闭扫描。在打开扫描时编辑列表扫描参数可能会产生错误。

3. 把扫描类型设置为列表扫描: 按下 SWEEP > Sweep Type List Step，突出显示 List。

4. 在 List Mode Values 表格编辑器中，把第 1 个点的驻留时间(在第 1 行中定义)变成 100 ms:

a. 按下 More > Configure List Sweep。

b. 突出显示第 1 个点的驻留时间。

c. 按下 100 > msec。

突出显示表格中的下一个项目(第 2 个点的频率值)。

5. 把选择的频率值变成 445 MHz: 按下 445 > MHz。

6. 在第 4 个点和第 5 个点之间添加一个新点: 突出显示第 4 行中的任何项，按下 Insert Row。

这会在第 4 行下面放一个第 4 行的拷贝，创建新的第 5 个点，并对后续行重新编号。

7. 把频率值下移一行，从第 5 个点开始: 突出显示第 5 行中的频率项目，然后按下 More > Insert Item。

这会把第 5 行和第 6 行的初始频率值下移一行，为第 8 行创建一个项目，其中只包含一个频率值

(功率和驻留时间项目不下移)。

8. 把第 5 行中仍在激活的频率值变成 590 MHz: 按下 590 > MHz。第 5 行中的功率现在变成激活参数。

9. 为第 5 个点插入一个新的功率值(-2.5 dBm)，把第 5 个点和第 6 个点的原始功率值下移一行:

按下 Insert Item > -2.5 > dBm。

10. 为编写第8个点的项目，把现有值的拷贝下移，插入第7个点驻留时间的拷贝: 突出显示第7行中的驻留时间，

按下 Insert Item。

11. 对模拟仪器，转到第 14 步。对矢量仪器，继续执行第 12 步。

12. 为第 2 个点选择一个波形:

a. 突出显示第 2 个点的波形项目，按下 More > SelectWaveform。

信号发生器显示提供的波形，如下例所示。

选择一个波形，

或

不选择任何调制。

b. 突出显示所需的波形(在本例中是 SINE_TEST)，按下 Select硬功能键或 SelectWaveform 软功能键。
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基本操作

配置扫描输出
13. 根据需要，对希望选择波形的其余点重复第 12 步。下图显示了显示屏示例。

14. 打开扫描: 按下Return > Return > Return > Sweep > Freq Off On > Amptd Off On > Waveform Off On。

15. 如果还没有打开 RF 输出，打开 RF 输出: 按下 RF On/Off。

显示屏上出现 SWEEP 指示符，表明信号发生器正在扫描，进度条显示扫描进度。

示例: 使用一次扫描

1. 设置步进扫描(第 28 页)或列表扫描(第 30 页)。

2. 在 List/Sweep 菜单中，把扫描重复次数设置为一次: 按下 Sweep Repeat Single Cont，突出显示 Single。

只有在触发时才会发生扫描。

注意显示屏上出现 WINIT 指示符，表明正在等待引起扫描。

3. 如果还没有打开 RF 输出，打开 RF 输出: 按下 RF On/Off。

4. 引起扫描: 按下 Single Sweep。

RF Output 连接器上提供重复一次的配置的扫描。

在信号发生器扫描时，SWEEP 指示符会在显示屏上代替 WINIT，进度条显示扫描进度。

在一次扫描结束时，不再有进度条，WINIT 指示符代替 SWEEP。

空项目相当于选择 CW

(没有调制)
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基本操作

配置扫描输出
示例: 手动控制扫描

1. 设置步进扫描(第 28 页)或列表扫描(第 30 页)。

2. 在 Sweep/List 菜单中，选择要扫描的参数: 按下 Sweep > 参数。

3. 选择手动模式: 按下 Return > More > Manual Mode Off On。

4. 如果还没有打开 RF 输出，打开 RF 输出: 按下 RF On/Off。

5. 选择要输出的点: 按下 Manual Point > 数字 > Enter。

6. 使用旋钮或箭头键，在各点之间移动。

信号路由选择

Sweep > More > More > Route Connectors >

SWMAN指示符表明扫描

处于手动模式。

在输入手动点时，进度条移

动并在选择的点上停止。

选择的扫描点参数定义了RF Output

连接器上提供的信号。

选择希望路由到每个输出连接器上的信号。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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基本操作

调制载波信号
调制载波信号

为调制载波信号，必须同时拥有:

激活的调制格式

和

已经打开 RF 输出调制

示例

1. 预设信号发生器。

2. 打开 AM 调制: 按下 AM > AM Off On (要求选件 UNT)。

可以在设置信号参数前或后打开调制格式。

调制格式生成、但不会调制载波信号。

一旦生成信号，会出现显示格式名称的指示符，表明调制格式激活。

3. 打开 RF 输出调制: 按下 Mod On/Off 键，直到 LED 灯亮。

如果在没有激活的调制格式的情况下打开调制，那么只有在以后打开调制格式时，载波信号才会调制。

4. 为在 RF 输出连接器上提供调制的载波，按下 RF On/Off 键，直到 LED 灯亮。

另参阅: “使用模拟调制(仅适用于选件 UNT)”，第 53 页

“使用脉冲调制(选件 UNU)”，第 57 页

“I/Q 调制”，第 121 页

指示符指明激活的AM 调制

AM 调制格式打开

LED灯亮表明任何激活的调

制格式都可以调制载波

注 为关闭调制，按下 Mod On/Off 键，直到 LED 灯关闭。

在 Mod On/Off 键为 off 时，即使使用激活调制格式，仍不调制载波信号。
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基本操作

查看、保存和调用数据
查看、保存和调用数据

信号发生器可以把数据存储为文件，并在文件目录中查看这些文件。从File Catalog中(如图 3-4中所示)，可

以删除、复制或重命名存储的文件。

查看存储的文件，第 36 页

保存和调用数据，第 37 页

另参阅:

处理仪器状态文件，第 38 页

选择内部或外部存储介质，第 41 页

存储、加载和播放波形段，第 70 页

图 3-4 文件软功能键

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

注: 提供的文件类型取决于安装的选件。

仪器操作参数(参阅第 38 页)

扫描 List Mode Values 表格编辑器中的数据

用户平坦度校准校正

参阅第 136 页

参阅第 41 页 波形文件及相关的标识和

头文件信息

注:

如果在没有连接USB存储介质的情况下打开External

Media菜单，信号发生器会显示信息: External Media

Not Detected (没有检测到外部存储介质)。
35Agilent N5181A/82A MXG 信号发生器用户指南



基本操作

查看、保存和调用数据
查看存储的文件

信号发生器中存储的文件

1. 按下 File > Catalog Type > 所需的目录。

目录中的文件会以字母顺序出现。文件信息包括文件:

名称

类型

大小

修改日期和时间

存储在外部存储介质上的文件

1. 连接外部存储介质。

仪器显示 External Media 目录。

2. 突出显示 USER 目录，按下 Select。

外部存储介质上的文件目录会以字母顺序出现，如下图所示。

使用Page Up和 Page Down键，

查看USER 目录的内容。
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基本操作

查看、保存和调用数据
保存和调用数据

存储和调用数据的方法取决于数据。

仪器状态文件包含仪器设置。对这类文件，使用Save和Recall硬功能键，如第38页图3-5所示。

对其它类型的数据，使用Load/Store软功能键(如下图所示)，可以通过创建文件使用的菜单进入

这些软功能键。

注 文件名称最长为 25 个字符。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

使用这个菜单输入文件名，

详情请参阅第 24 页。
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基本操作

查看、保存和调用数据
仪器设置(状态)保存到仪器状态存储器中，它分成 10个序列

(0 - 9); 每个序列由 100 个寄存器组成(00 - 99)。

通过删除 Save 和 Recall 菜单中的软功能键，可以删除某个

寄存器的内容或状态文件目录中所有序列的内容。

信号发生器要求确认删除操作。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

处理仪器状态文件

图 3-5 Save 和 Recall软功能键

示例: 保存仪器状态

1. 预设信号发生器，设置如下:

·频率: 800 MHz       ·幅度: 0 dBm       ·RF: on

2. (可选，仅适用于矢量型号) 把一个波形文件与这些设置关联起来：

a. 按下 Mode > Dual ARB > Select Waveform。

b. 突出显示所需的文件，按下 Select Waveform。如果没有列出文件，必须先把文件从内部或外部存储

介质移动到 BBG 存储介质上，参阅第 71。

3. 选择所需的存储器序列 (在本例中是 1): 按下 Save > Select Seq > 1 > Enter。

4. 选择所需的寄存器 (在本例中是 01): 按下 Select Reg > 1 > Save Reg。

如果波形是当前选择的波形，那么保存仪器状态也会保存波形文件名称。

5. 在第 1 个序列的第 01 个寄存器中添加说明注释。

按下 Add Comment to Seq[1] Reg[01]，输入注释，按下 Enter。在按下 Recall时，注释会出现在

Saved States 列表中。如果仪器状态有一个相关波形，那么输入波形名称可以简便地识别哪个仪器状态与

哪个波形对应。

状态文件中没有存储下述信息:

系统安全等级 列表模式频率 主机名称 远程语言 FM 偏差

系统安全等级显示 列表模式功率 IP 地址 FTP 服务器 PM 偏差

系统安全等级状态 列表模式驻留 子网掩码 手动 DHCP MAC

Web 服务器 (HTTP) 列表模式序列 默认网关 VXI-11 SCPI 用户功率校正

套接字 SCPI (TELNET) 显示状态开 / 关 ARB 文件 列表文件 I/Q 校准数据
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基本操作

查看、保存和调用数据
示例: 调用仪器状态

1. 预设信号发生器。

2. 按下 Recall。

Select Seq 软功能键显示最后使用的序列，显示屏列出该序列中的寄存器中存储的任何状态;

RECALL Reg是激活项目。

3. 选择所需的仪器状态:

如果在当前选择的序列中列出了所需的状态，按下所需的数字 > Enter。

否则，按下Select Seq > 所需的数字 > Enter > RECALL Reg > 所需的数字 > Enter。

示例: 调用仪器状态和相关波形文件

1. 调用所需的仪器状态 (参阅上一个示例)。

2. 查看调用的波形文件名及仪器状态: 按下 Mode > Dual ARB。

名称显示为选择的波形。调用仪器状态只会调用波形名称。如果删除文件，那么它不会重建波形文件;

如果文件位于内部或外部存储介质中，那么它会把文件加载到 BBG 存储介质中。

3. 保证存在所需的波形文件，且位于 BBG 存储介质中(第 71 页)。

如果波形文件没有位于 BBG 存储介质中，执行下一步操作会产生错误。

4. 打开波形文件: 按下 Mode > Dual ARB > ARB Off On。

示例: 凋用仪器状态和相关列表文件

调用仪器状态只会调用列表扫描设置，而不会调用频率和/或幅度值。由于必须从文件目录中加载列表文件，

因此在存储列表文件时，一定要提供一个描述性的名称(最长 25 个字符)。

1. 调用所需的仪器状态(参阅上一个示例)。

2. 调用所需的列表文件:

a. 按下 Sweep > More > Configure List Sweep > More > Load/Store。

b. 突出显示所需的文件，按下 Load From Selected File > Confirm Load From File。
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基本操作

查看、保存和调用数据
注

为定义用户预设值，根据需要设置仪器，按下 User > Save User Preset。

移动或复制存储的仪器状态

图 3-6 仪器状态文件目录

为改变保存仪器状态的注释:

1. 按下 Save。

2. 突出显示所需的寄存器。

3. 按下 Edit Comment In Seq[n] Reg [nn]。

4. 按下 Re-SAVE Seq[n] Reg[nn]。

这会用新注释覆盖以前保存的仪器状态设置。

序列 寄存器

用户创建的状态文件的默认名称是

其存储器位置。

为移动文件，把文件重命名为所需

的序列和寄存器。

为文件提供的名称不能与现有文件

的名称相同。

注意

如果把状态文件重命名为有效序列/

寄存器名称之外的名称,  那么在

Save 或 Recall 菜单中都不会出现

文件。

用户预设信息

如果重命名这个文件，信号发生器不再把它识别为用户预设信息。

定义用户预设值

根据需要设置仪器，然后按下 User > Save User Preset。

创建一个以上的用户预设值

在不同名称下设置多个预设条件; 把希望使用的名称命名为USRPRST。为使

用不同的文件，重命名当前USRPRST，然后把所需的文件命名为USRPRST。
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基本操作

查看、保存和调用数据
信号发生器不会格式化外部存储介质，创建目录，或改变文件权限。应使用计算机完成这些操作。

选择内部或外部存储介质

在 External Media 菜单中(如下图所示)，选择所需的存储类型。

文件类型 扩展名 保存来源 在突出显示文件时按下 Select...

列表 .list Sweep 菜单 加载列表，开始扫描

状态 .state Save 菜单 加载仪器状态

波形 .waveform Mode 菜单 加载和播放波形

用户平坦度 .uflat Amplitude 菜单 加载和应用用户平坦度

用户预设值 .uprst User Preset 菜单 加载和执行用户预设值

许可 .lic 从安捷伦科技购买 安装购买的许可

File > More >
External Media File Manager >

非易失性存储器

Int = 内部

Ext = 外部; 如果没有连接存储棒, 那么不能使用

非易失性存储器。

Auto = 在存在时使用外部存储器, 否则使用内部存储器。

文件长度 (包括扩展名)

内部存储介质: 25 个字符

外部存储介质: 39 个字符

要求确认

使用外部存储介质

在把存储介质连接到前面板 USB 连接器时，信号发生器显示下图所示的菜单及 External USB Storage at
tached(外部 USB 存储器已连接)信息。在断开 USB 存储介质时，会显示 External USB Storage detached (外部

USB 存储器已断开)信息。在没有连接 USB 存储介质的情况下打开 External Media 菜单时，信号发生器显示

External Media Not Detected (没有检测到外部存储介质)信息。

为设置信号发生器在外部存储介质上使用的目录:

1. 进入目录，目录将显示在路径中。

    2. 按下这个软功能键。

为进入目录, 使用Select硬功能

键和 Up Directory 软功能键。

删除、备份和恢复操作要求确认。
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基本操作

阅读错误信息
阅读错误信息

如果发生错误条件，信号发生器把它同时报告给前面板显示错误队列和 SCPI (远程接口)错误队列。这两个

队列分开查看和管理，如需与 SCPI 错误队列有关的信息，参阅编程指南。

特点 前面板显示错误队列

容量(错误数量) 30

溢出处理 在每个新错误进入时丢掉最老的错误

查看项目 按下: Error > View Next (或 Previous) Error Page

清除队列 按下: Error > Clear Error Queue(s)

没有解决的错误 a 在清除队列后重新报告

没有错误 在队列为空时(已经读取队列中的每个错误，或清除了队列)，

队列中会出现下述信息: No Error Message(s) in Queue  of 
a 必须解决的错误，如解锁。

错误信息格式

在前面板显示错误队

列中，将以枚举的方式(“1

of N”) 显示错误信息。

错误编号 错误信息

错误描述

(在显示屏上可能会被截短)

数据超出范围 取值削短到下限

Error Message 文件提供解释信息(参阅第 148 页)

(仪器上没有显示)

指示符表明有一条信息没有查看。

New 表明自从上次查看信息

以来生成了一条新信息。

信息编号和较长的描述

在发生错误时，错误信息出现在

显示屏的左下角。

Indicates that the  user has entered a deviation, depth, or internal

source frequency that is beyond the specific limits
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在使用这些信息前，应该已经熟悉信号发生器的基本操作。如果不熟悉设置功率电平和频率等功能，请参阅

第 23 页第 3 章“基本操作”，熟悉该章中的信息。

使用用户平坦度校正，第 44 页

使用未调整电平工作模式，第 47 页

使用输出偏置、参考或倍数，第 49 页

4   优化性能
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优化性能

使用用户平坦度校正
使用用户平坦度校正

用户平坦度校正功能可以为最多1601个顺序线性或任意间隔的频率点调节RF输出幅度，补偿电缆、开关或

其它设备中的外部损耗。

可以创建和保存各个用户平坦度校正表，针对各种测试设置或频率范围调用不同的校正阵列(参阅第46页)。

基本步骤

1. 创建用户平坦度阵列: 输入用户平坦度校正值。

2. (可选)保存用户平坦度校正数据。

3. 对 RF 输出应用用户平坦度校正。

图 4-1 用户平坦度校正软功能键

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

确认
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优化性能

使用用户平坦度校正
示例: 带有 10 个校正值的 500 MHz - 1 GHz 平坦度校正阵列

创建用户平坦度阵列

1. 配置信号发生器:

a. 预设信号发生器。

b. 打开 User Flatness 表格编辑器，预设校准阵列:

按下Amptd > More > User Flatness > Configure Cal Array > More > Preset List > Confirm Preset。

c. 在 Step Array 菜单中，输入所需的平坦度校正频率:

按下 Configure Step Array >

Freq Start > 500 > MHz >

Freq Stop > 1 > GHz >

# of Points > 10 > Enter

d. 使用上一步中配置的步进阵列填充用户平坦度校正阵列:

按下 Return > Load Cal Array From Step Array > Confirm Load From Step Data。

e. 把输出幅度设置成 0 dBm。

f. 打开 RF 输出。

2. 把功率计连接到 RF 输出上，手动输入校正值:

a. 打开 User Flatness 表格编辑器，在第 1 行中突出显示频率值:

按下 More > User Flatness > Configure Cal Array。

RF 输出变成包含光标的表格行的频率值。

b. 注意功率计测得的值。

c. 从 0 dBm 中减去测得的值。

d. 在第 1 行中突出显示校正值。

e. 按下 Select > 第 c 步中计算的差值 > Enter。

信号发生器根据输入的校正值调节输出幅度。

f. 如果功率计的读数不是 0 dBm，调节第 e 步中的值，直到读数为 0 dBm。

g. 在下一行中突出显示频率值。

h. 对这一行及其余行重复第 b 到 g 步。

用户平坦度校正阵列头文件显示 User Flatness:，不带名称，表明当前用户平坦度校正阵列数据还没有保存

到文件目录中。
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优化性能

使用用户平坦度校正
可选: 保存用户平坦度校正数据

1. 按下 Load/Store > Store to File。

2. 输入一个文件名 (在本例中是 FLATCAL )，按下 Enter。

用户平坦度校正阵列文件现在作为UFLT文件存储在文件目录中。可以调用保存到目录中的任何用户平坦度

校正文件，这些文件可以加载到校正阵列中，应用到 RF 输出上，满足特定的 RF 输出平坦度要求。

3. 按下 Return。

在 RF 输出上打开平坦度校正

按下 Return > Flatness Off On。

UF 指示符出现在显示屏的幅度区域，阵列中的校正数据应用到 RF 输出上。

调用和应用用户平坦度校正阵列

下例假设已经创建和存储了一个用户平坦度校正阵列。如果还没有创建和存储阵列，应执行第 45 页

“示例: 带有 10 个校正值的 500 MHz - 1 GHz 平坦度校正阵列”。

1. 预设信号发生器。

2. 调用所需的用户平坦度校正文件:

a. 按下AMPTD > More > User Flatness > Configure Cal Array > More > Preset List > Confirm Preset。

b. 按下 More > Load/Store。

c. 突出显示所需的文件。

d. 用选定文件中包含的数据填充用户平坦度校正阵列:

按下 Load From Selected File > Confirm Load From File。

用户平坦度校正阵列头文件显示为 User Flatness: 文件名。

3. 把阵列中的校正数据应用到 RF 输出: 按下 Return > Flatness Off On。
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优化性能

使用未调整电平工作模式
ALC Off 模式

关闭ALC会使信号发生器的自动置平电路无效，可以在测试设置的某个点上测量输出，根据该点上所需的

功率电平要求进行调节。关闭ALC适用于调制由非常窄的低于ALC脉宽规范的脉冲组成的情况，或适用于调制

由自动置平可以消除的低速幅度变化组成的情况。

1. 预设信号发生器。

2. 设置所需的频率。

3. 设置所需的幅度。

4. 把功率计连接到需要某个功率电平的点上。

5. 打开 RF 输出。

6. 禁用信号发生器的自动置平控制: 按下 AMPTD > ALC Off On，突出显示 Off。

7. 调节信号发生器的幅度，直到功率计测量所需的电平。

使用未调整电平工作模式

图 4-2 功率搜索和 ALC Off软功能键

Auto: 在输出频率或幅度变化时

执行校准程序。

Span: 按下 Do Power Search 在选择的

频率范围上执行功率搜索校准程序一次。

在把信号发生器调谐到校准后的频率范围

内时，存储和使用校正数据。

只有在ALC = Off
时才能使用

只有在 Power Search = Span
时才能使用

只有在 Power Search = Span且

Span Type = User 时才能使用

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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优化性能

使用未调整电平工作模式
功率搜索模式

参阅第47页图4-2。功率搜索执行一个程序，临时激活ALC，校准当前RF输出的功率，然后断开ALC电路。

注 为执行功率搜索程序，RF 必须打开，ALC 必须关闭。

示例: 自动功率搜索

1. 预设信号发生器。

2. 设置所需的频率。

3. 设置所需的幅度。

4. 打开 RF 输出。

5. 禁用信号发生器的自动置平控制：

按下 AMPTD > ALC Off On，突出显示 Off

禁用信号发生器自动置平控制是一个重大的仪器变化，它会自动引起功率搜索。

在设置为 Auto 时，在仪器设置发生重大变化时会自动执行功率搜索。Do Power Search 可以执行功率搜索，

补偿其它变化，如温度漂移或外部输入变化。
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优化性能

使用输出偏置、参考或倍数
使用输出偏置、参考或倍数

设置输出偏置

通过使用输出偏置，信号发生器可以输出偏离输入值的频率或幅度(正或负)。

RF 输出 = 输入的值 - 偏置值

显示的值 = 输出频率 + 偏置值

为设置偏置:

频率 : 按下 Freq > Freq Offset > 偏置值 > 频率单位。

幅度 : 按下 Amptd > More > Amptd Offset > 偏置值 > dB。

表明偏置打开

示例

参数 示例 #1 示例 #2 示例 #3 备注

输入的(和显示的)值: 300 MHz 300 MHz 2 GHz 输入的值必须是正数。

偏置: 50 MHz -50 MHz -1 GHz 偏置值可以是正数，也可以是负数。

输出频率: 250 MHz 350 MHz 3 GHz 如果输出频率或幅度超出范围，信号发生器会发出警报。

在使用信号发生器作为本振(LO)时，可以使用偏置显示感兴趣的频率，如下图所示:

选择的偏置 信号发生器显示

321 MHz 1321 MHz (天线频率)

-679 MHz 321 MHz (IF 输出)

天线调谐到 1321 MHz

RF 放大器 混频器 滤波器
IF 输出

输出频率 = 1000 MHz

信号发生器

(本振)

IF放大器

321 MHzIF = 321 MHz
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优化性能

使用输出偏置、参考或倍数
表明参考打开

示例

参数 示例 #1 示例 #2 示例 #3 备注

参考: 50 MHz 50 MHz 2 GHz 输入的值必须是正数。

输入的(和显示的)值: 2 MHz -2 MHz -1 GHz 输入的值可以是正数，也可以是负数。

输出频率: 52 MHz 48 MHz 1 GHz 如果输出频率或幅度超出范围，信号发生器会发出警报。

为设置新的频率或幅度参考，先关闭频率参考，然后采取上述步骤。

设置输出参考

通过使用输出参考，信号发生器可以输出较选择的参考值偏离输入值的频率或幅度(偏置可以是正或负)。

RF 输出 = 参考值 + 输入值

为设置参考:

1. 把频率或幅度设置成希望作为输出参考电平的值。

2. 频率: 按下频率 > Freq Ref Set

频率显示 0.00 Hz，表明这是 RF 输出频率“零电平”。输入的所有频率解释为相对于这个参考

频率的值。

幅度: 按下 Amptd > More > Amptd Ref Set

幅度显示 0.00 dB，表明这是 RF 输出幅度“零电平”。

输入的所有幅度都解释为相对于这个参考幅度的值。
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优化性能

使用输出偏置、参考或倍数
选择的 输入 /显示的 信号发生器

倍数 频率 输出

2 4 GHz 2 GHz

设置频率倍数

通过使用频率倍数，信号发生器可以显示是输出值倍数的频率(倍数可以是正或负)。

显示的值 = 倍数值 x 输出频率

输出频率 = 显示的值 ÷ 倍数值

为设置频率倍数:

1. 按下 Frequency > Freq Multiplier > 倍数值 > x。

2. 设置所需的频率。

显示屏内容等于输出频率乘以倍数值。

表明频率倍数打开

示例

参数 示例 #1 示例 #2 示例 #3 备注

频率倍数: 3 -3 4 倍数值可以是正数，也可以是负数。

输入的(和显示的)值: 600 MHz -600 MHz 8 GHz

输出频率: 200 MHz 200 MHz 2 GHz 如果输出频率或幅度超出范围，信号发生器会发出警报。

在使用信号发生器作为系统输入时，可以设置频率倍数，以便信号发生器显示系统输出，如下面使用倍频器

所示:

信号发生器 倍频器

输入 = 2 GHz 输出 = 4 GHz
x2
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优化性能

使用输出偏置、参考或倍数
选择的 选择的 输入 /显示 信号发生器

倍数 偏置 的频率(fIF) 输出 (fLO)
-1 3000 MHz 2200 MHz 800 MHz
-1 3000 MHz 2400 MHz 600 MHz

在测量混频器时，频率倍数和频率偏置通常会一起使用。在下面的向上变频器示例中，倍数设为 -1，

偏置设为 3 GHz，以便信号发生器显示 fRF。

混频器

信号发生器

(本振)

fRF = 2200 - 2400 MHz fIF = 3000 MHz

fLO = 800-600 MHz
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如需每个键的详细信息，

使用第 23 页介绍的帮助键。

在使用这些信息前，应该已经熟悉信号发生器的基本操作。如果不熟悉设置功率电平和频率等功能，请参阅

第 23 页第 3 章“基本操作”，熟悉该章中的信息。

基本步骤，第 54 页

使用外部调制源，第 55 页

消除直流偏置，第 55 页

5   使用模拟调制 (仅适用于选件 UNT)

图 5-1 模拟调制软功能键

参阅

第 55 页

参阅

第 55 页
参阅

第 55 页
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使用模拟调制 (仅适用于选件 UNT)

基本步骤
基本步骤

1. 预设信号发生器。

2. 设置载波(RF)频率。

3. 设置 RF 幅度。

4. 配置调制:

AM FM ΦΦΦΦΦM

a. 按下 AM a. 按下 FM/ΦΦΦΦΦM a. 按下 FM/ΦΦΦΦΦM > FM ΦΦΦΦΦM

b. 设置 AM 类型 (线性或指数): b. 设置偏差: b. 设置带宽 (正常或高):

AM Type，突出显示所需的类型 FM Dev > 设定值 > 频率单位 FM ΦΦΦΦΦM，突出显示所需的类型

c. 设置深度: c. 设置速率: c. 设置偏差:

AM Depth > 设定值 > % FM Rate > 设定值 > 频率单位 ΦΦΦΦΦMDev > 设定值 > pi rad

d. 设置速率: d. 设置速率:

AM Rate > 设定值 > 频率单位 ΦΦΦΦΦM Rate > 设定值 > 频率单位

5. 打开调制:

AM FM ΦΦΦΦΦM

AM Off On 软功能键到 On FM Off On 软功能键到 On ΦΦΦΦΦM Off On 软功能键到 On

显示相应的调制指示符，表明已经打开了调制。

6. 打开 RF 输出。

RF 输出 LED 灯亮，表明正从 RF 输出连接器中传输信号。

如果调制似乎没有正确工作，请参阅第 143 页“RF 输出上没有调制”。

另参阅第 34 页“调制载波信号”。
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使用模拟调制 (仅适用于选件 UNT)

使用外部调制源
使用外部调制源

消除直流偏置

为消除外部应用的 FM 或ΦM 信号中的偏置，执行 DCFM 或 DC ΦM 校准。

注 可以对内部生成的信号执行这一校准，但直流偏置通常不是内部生成的信号的特点。

1. 设置和打开所需的调制。

2. 按下 FM/ΦΦΦΦΦM > More > DCFM/DCΦΦΦΦΦM Cal。

使用应用的 DC 信号执行校准可以消除 DC 信号导致的任何偏差，应用的 DC 电平变成新的零参考点。在断

开 DC 信号时，再次执行校准，把载波复位到正确的零参考电平。

当前选择的调制

默认值

选择使用外部调制

第 9 页介绍了后面板输入

AM 输入 FM或ΦM 输入
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使用模拟调制 (仅适用于选件 UNT)

使用外部调制源



在使用这些信息前，应该已经熟悉信号发生器的基本操作。如果不熟悉设置功率电平和频率等功能，请参阅

第 23 页第 3 章“基本操作”，熟悉该章中的信息。

脉冲特点，第 59 页

基本步骤，第 61 页

示例，第 61 页

6   使用脉冲调制 (选件 UNU)
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使用脉冲调制 (选件 UNU)
图 6-1 脉冲软功能键

参阅第 61 页

参阅第 61 页

确定信号发生器怎样响应外部

脉冲信号。

正常(Normal) = 高状态。

反转(Invert) = 低状态。

另参阅第 9 页

和第 10 页

低 = 已稳定

从外部脉冲输入到脉冲同

步输出的时延≈ 50 - 60 ns。

宽度 周期

50 ns > 50 ns

20 ns ≤ 50 ns

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

TTL 信号

选择信号希望路由到

每个输出连接器的信号。
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使用脉冲调制 (选件 UNU)

脉冲特点
脉冲特点

注 在使用低于信号发生器 ALC 脉宽规范的非常窄的脉冲或使用占空比异常长的置平脉冲时，

通常需要关闭 ALC (参阅第 47 页)。

脉冲来源 类型 周期 a 宽度和延迟 a 使用触发事件 b

方波 内部自由运行脉冲串, 由用户定义的速率确定 — —

50% 占空比

自由运行 内部自由运行脉冲串 用户定义 用户定义 —

(默认值)

已触发 内部脉冲串 — 用户定义 —

可调节的偶极 每个触发事件两个 — 用户定义: 第一个脉冲 ✓

内部脉冲串 相对于触发信号的上升沿;

第二个脉冲相对于第一个

脉冲的上升沿。

参阅第 60 页图 6-2

触发偶极 每个触发事件两个 — 第一个脉冲采用触发信号。 ✓

内部脉冲串 第二个脉冲由用户定义。

参阅第 60 页图 6-3

选通 内部选通的脉冲串 — 用户定义 ✓

外部 背面板 Pulse 连接器上的 — — —

外部脉冲信号

a 所有延迟、宽度和周期的分辨率均为 10 ns。
b 后面板脉冲连接器上的信号必须保持高至少 20 ns，以触发内部生成的脉冲。

第 9 页介绍了后面板输入

外部脉冲输入
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使用脉冲调制 (选件 UNU)

脉冲特点
第二个脉冲的延迟从外部触

发信号的前沿测得。

图 6-2 可调节的偶极

外部触发

RF 输出

延迟 宽度

第一个脉冲的延迟从外部触发

信号的前沿测得。
延迟 宽度

第二个脉冲的延迟从第一个脉冲的前沿测得。

图 6-3 触发偶极

外部触发

RF 输出

延迟 宽度

第一个脉冲跟随外部

触发信号。
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使用脉冲调制 (选件 UNU)

基本步骤
基本步骤

1. 预设信号发生器。

2. 设置载波 (RF) 频率。

3. 设置 RF 幅度。

4. 配置调制:

a. 设置脉冲来源: 按下 Pulse > Pulse Source > 选择

b. 为选择的脉冲来源设置参数:

方波 自由运行 (默认值) 已触发 可调节的偶极 触发偶极 选通 外部

脉冲速率 — — — — — —

— 脉冲周期 — — — 脉冲周期 —

— 脉冲延迟 脉冲延迟 脉冲延迟 脉冲延迟 — —

— 脉宽 脉宽 脉宽 脉宽 脉宽 —

— — — 脉冲 2 延迟 — — —

— — — 脉冲 2 宽度 — — —

5. 打开调制: 把 Pulse Off On 软功能键拨到 On。

PULSE 指示符灯亮，表明已经打开了调制。

6. 从信号发生器输出调制的信号: 按下前面板 RF On Off 键。

RF 输出 LED 灯亮，表明正从 RF 输出连接器输出信号。

另参阅“调制载波信号”，第 34 页。

示例

下面的示例使用出厂时预设的脉冲来源和延迟。

输出: 由周期为 100 µs 的 24 µs 脉冲调制的 2 GHz, 0 dBm 载波。

1. 预设信号发生器。

2. 把频率设置为 2 GHz。

3. 把幅度设置为 0 dBm。

4. 把脉冲周围设置为 100 微秒: 按下 Pulse > Pulse Period > 100 > usec

5. 把脉宽设置为 24 微秒: 按下 Pulse > Pulse Width > 24 > usec

6. 同时打开脉冲调制和 RF 输出。

出现 PULSE 指示符，RF 输出 LED 灯亮。

如果调制似乎没有正确工作，请参阅第 143 页“RF 输出上没有调制”。
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使用脉冲调制 (选件 UNU)

示例



在使用这些信息前，应该已经熟悉信号发生器的基本操作。如果不熟悉设置功率电平和频率等功能，请参阅

第 23 页第 3 章“基本操作”，熟悉该章中的信息。

另参阅: “在双重 ARB 波形中增加实时噪声”，第 130 页。

7   基本数字操作 — 没有安装 BBG 选件
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基本数字操作 — 没有安装 BBG选件

I/Q 调制
下表显示了调节的常见用途。

表 7-1 I/Q 调节用途

I/Q 调节 影响 劣化

偏置 载波馈通 直流偏置

正交角
EVM 误差 I/Q 镜像

相位偏移 I/Q 路径延迟

I/Q 调制

下述因素影响着错误矢量幅度:

I 通道和 Q 通道之间幅度、相位和延迟差

直流偏置

I/Q 菜单提供了调节功能，补偿 I 和 Q 信号中的部分差异，或增加劣化。

另参阅第 34 页“调制载波信号”。

图 7-1 I/Q 显示和软功能键

这个面板显示了 I/Q 信号路由。

这个面板显示了 I/Q 调节的当前状

态和设置。灰色表明 I/Q调节关闭。

设置直流偏置

如需每个键的详细信息,

使用第 23 页介绍的帮助键。

相对于 I信号的相位偏移Q信号的相位。以度为单位校

准正交调节键。这个调节功能未被校准。
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基本数字操作 — 没有安装 BBG 选件

I/Q 调制
配置前面板输入

Agilent MXG 通过前面板 I 输入和 Q 输入接受外部提供的模拟 I 和 Q 信号，以调制到载波上。

1. 把 I 信号和 Q 信号连接到前面板连接器上。

a. 把模拟 I 信号连接到信号发生器的前面板 I 输入上。

b. 把模拟 Q 信号连接到信号发生器的前面板 Q 输入上。

2. 打开 I/Q 调制器: 按下 I/Q Off On 到 On。

3. 配置 RF 输出:

a. 设置载频。

b. 设置载波幅度。

c. 打开 RF 输出。

4. 根据需要调节 I/Q 信号 (第 64 页)。
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基本数字操作 — 没有安装 BBG选件

I/Q 调制



在使用这些信息前，应该已经熟悉信号发生器的基本操作。如果不熟悉设置功率电平和频率等功能，请参阅

第 23 页第 3 章“基本操作”，熟悉该章中的信息。

本章中介绍的功能只适用于配有选件 651、652 或 654 的矢量信号发生器。

波形文件基础知识，第 68 页

存储、加载和播放波形段，第 70 页

设置基带频率偏置，第 72 页

波形序列，第 74 页

保存波形设置和参数，第 78 页

使用波形标识，第 82 页

触发波形，第 98 页

波形削减，第 105 页

幅值缩放波形，第 114 页

I/Q 调制，第 121 页

另参阅: “在双重 ARB 波形中增加实时噪声”，第 130 页

8   基本数字操作 (选件 651/652/654)
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波形文件基础知识
波形文件基础知识

波形文件分成两种类型:

波形段是下载到信号发生器中的波形文件。如需与创建和下载波文件有关的信息，请参阅编程

指南。

序列是在信号发生器中创建的包含指向一个或多个波形文件(波形段、其它序列或两者)的指针的文

件。如需与创建序列有关的信息，请参阅第 74 页。

信号发生器存储器

信号发生器有两类存储器:

易失性存储器，这是一种基带发生器(BBG)存储介质，从这一存储介质中播放或编辑波形文件。

非易失性存储器，这是一种内部(int)存储介质或外部(USB)存储介质，其中存储波形文件。

双重 ARB 播放器

双重ARB波形播放器可以播放、重命名、删除、存储和加载波形文件及构建波形序列。双重ARB

波形播放器还提供标识(第 82 页)、触发(第 98 页)、削减(第 105 页)和幅值缩放(第 114 页)功能。

本节中的大部分步骤从双重 ARB 菜单开始，如下图所示。
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波形文件基础知识
如需每个键的详细信息，

使用第 23 页介绍的帮助键。

图 8-1 双重 ARB 软功能键

注: 这是三个

Arb 菜单中

的第一个菜单。

如果在双重ARB关闭时设置ARB采样时钟,
那么新的采样时钟设置将在双重 ARB 播放

器打开时被启用。这一设置在双重ARB播放

器关开时，也仍将保留。

第 70 页
第 130 页

第 114 页

第 72 页

第 10 页

第 114 页

第 10 页

注: 这是三个 Arb 菜单中的

第二个菜单。

第 82 页

第 74 页

第 78 页

注: 这是三个 Arb 菜单中的

第三个菜单。
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存储、加载和播放波形段
存储、加载和播放波形段

另参阅查看、保存和调用数据，第 35 页。

图 8-2 波形段软功能键

把波形段存储 /重命名到非易失性存储器 (内部存储介质或外部存储介质)

使用下面的步骤把BBG存储器中的文件拷贝存储到当前选择的存储介质中(第 41页)。如果还没有下载波形

段，请参阅编程指南，或使用出厂时提供的其中一个波形段。

1. 按下 Mode > Dual ARB > Select Waveform > Waveform Segments。

2. 在 Segment On BBG Media 栏中，突出显示任何波形段。

3. 按下 Load Store，突出显示 Store。

4. 突出显示想要存储的波形段。

5. (可选)重命名波形段。

如果在当前选择的存储介质中已经有这个波形段的拷贝，而且不想覆盖它，那么在存储前应重命名波形段：

a. 按下 More > Rename Segment > Clear Text。

b. 输入波形段的名称。

c. 按下 Enter > More。

d. 突出显示重命名后的波形段。

6. 按下 Store Segment to 当前选择的 Media。

使用箭头键或旋钮，

突出显示一个字母或字符

参阅第82页
注: 在突出显示一个序列时，这个键的名称会变

成 Show Waveform Sequence Contents。

如需每个键的详细信息;

使用第 23 页介绍的帮助键。
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存储、加载和播放波形段
7. 对希望存储的所有波形段，重复第 4 步到第 6 步。

为把 BBG 存储介质中的所有波形保存到当前选择的存储介质中，按下 Store All to 当前选择的 Media。

把波形段加载到 BBG存储介质(易失性存储器)中

波形段必须存于BBG存储介质中，然后才能播放、编辑或包括在一个序列中。开关电源或重新引导信号发

生器会删除 BBG 存储介质中的文件。

注 每次仪器开机时，在 BBG 存储介质中会自动创建两个出厂时提供的波形段:

RAMP_TEST_WFM 和 SINE_TEST_WFM。

1. 按下 Mode > Dual ARB > Select Waveform > Waveform Segments。

2. 按下 Load Store，突出显示 Load。

3. 突出显示希望加载的波形段。

4. 如果在当前选择的存储介质中已经有这个波形段的拷贝，而且不想覆盖它，那么在加载前应重命名波形段

(参阅上面的步骤)。

5. 按下 Load Segment From 当前选择的 Media。

为把所有文件从当前选择的存储介质加载到 BBG 存储介质中，按下 Load All From 当前选择的 Media。

播放波形段

1. 按下 Mode > Dual ARB > Select Waveform。

2. 在 Segment on BBG Media 栏中，突出显示希望播放的波形段。

3. 按下 Select Waveform > ARB Off On 到 On。

这会播放选择的波形段。在波形段生成过程中，I/Q 指示符和 ARB 指示符都会打开，波形会调制 RF 载波。

4. 配置 RF Output:

a. 设置 RF 载频。

b. 设置 RF 输出幅度。

c. 打开 RF 输出。

信号发生器 RF OUTPUT 连接器上现在提供波形段。

当有激活的波形时，指示符的显示(ARB On)

当前波形选择
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设置基带频率偏置
设置基带频率偏置

图 8-3 Baseband Frequency Offset 软功能键

基带频率偏置可以在 BBG 100 MHz 信号带宽范围内使基带频率位移高达 ± 50 MHz，具体取决于信号发生

器的基带发生器选件。偏置功能的常见用途包括:

从任何 LO 馈通偏置载波(载频上的载波信号激励源)

把基带信号与外部 I 和 Q 输入相加，创建多载波信号

使用信号发生器的 I/Q 信号作为 IF

注 改变基带频率偏置可能会导致DAC超出范围情况，生成错误 : Baseband Generator DAC over range
(基带发生器 DAC 超出范围)。在发生这种情况时，应降低波形运行时幅值缩放值(第 114 页)。

基带频率偏置值是其中一个头文件参数(第78页)，表示可以与波形一起存储这个值。在选择具有存储的频率

偏置值的波形时，信号发生器会改变当前值，以与存储的头文件值相匹配。如果当前波形没有存储的基带偏置频

率值，信号发生器会使用上一次设置的频率偏置值。

还可以使用Save功能(第 35页)，作为信号发生器设置的一部分存储这个值。在Recall使用 Save功能存储的

设置时，基带频率偏置值变成当前仪器设置值，而不考虑存储的头文件值是多少。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

频率偏置设置。

参阅第 114 页

参阅第 130 页

这个菜单中的设置可以存储

到头文件中，参阅第 78 页。
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设置基带频率偏置
使用下述步骤，从LO/载波馈通偏置载波。本例使用出厂时提供的波形SINE_TEST_WFM。为查看本例的输

出，把信号发生器的 RF OUTPUT 连接到频谱分析仪的输入上。

1. 选择和播放波形。

a. 按下 Mode > Dual ARB > Select Waveform。

b. 在 Segment On BBG Media 栏中，选择 SINE_TEST_WFM。

c. 按下 Select Waveform。

2. 生成波形: 按下 ARB Off On 到 On。

3. 配置载波信号:

a. 把载波信号设置成 1 GHz。

b. 把幅度设置成 0 dBm。

c. 打开 RF OUTPUT。

4. 按下 ARB Setup > Baseband Frequency Offset > 20 MHz。

调制的 RF 信号现在偏离载频 20 MHz，如下图所示。

使用 0 Hz 基带频率偏置的被调制载波 使用 20 Hz 基带频率偏置的被调制载波

被调制的 RF 信号

频谱分析仪设置成 100 MHz 跨度

LO/carrier feedthrough

(本振 /载波馈通)
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波形序列
波形序列

图 8-4 波形序列软功能键

波形序列包含指向一个或多个波形段或其它波形序列或两者的指针的文件。这使得信号发生器能够播放多个

波形段或其它序列或两者，而不需要停止播放波形，选择另一个波形。

在存储序列时，不会自动存储波形序列指向的波形段。用户还必须存储各个波形段，否则在关闭或重新引导

信号发生器时，这些波形段会丢失。如果波形段位于内部 /外部存储介质中，那么在选择一个波形序列前，必须

把它们加载到BBG存储介质中。如果试图在没有把波形段加载到BBG存储介质的情况下播放序列，信号发生器

会报告 ERROR:  File format invalid (文件格式无效)。如果发生这种情况，且波形段没有存储在内部 / 外部

存储介质中，那么必须使用序列指向的相同的文件名重新创建波形，然后才能播放序列。

Mode >
Dual ARB >

为显示这个软功能键，突出显示一个波形序列
序列名称

序列内容

参阅第 95 页

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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波形序列
创建序列

一个波形序列最多可以包含 1,024 个波形段，并可以同时包括波形段和其它序列(嵌套序列)。信号发生器可

以设置播放过程中波形段和嵌套序列的重复次数。但重复波形段和重复嵌套序列有一个差别。每个波形段最多可

以重复65,535次，但不管波形段怎样重复，它都作为一个波形段计数。而每次重复一个嵌套序列都作为额外的波

形段计数。

一个嵌套序列可以重复的最大次数取决于嵌套序列中的波形段数及余下的允许波形段数(1,024个)。例如，如

果一个序列包含 24 个波形段和 1 个有 4 个波形段的嵌套序列，那么嵌套序列的重复次数限于 250 次:

24 + (4 × 250) = 每个序列最多 1,024 个波形段

尽管对嵌套序列可以重复的最大次数有限制，但嵌套序列中的每个波形段最多可以重复 65,535 次。

示例

使用下面的步骤，创建和存储一个波形序列，其中采用两个不同的波形段，每个波形段重复一次。

前提: 这些波形段存储在 BBG 存储介质(易失性存储器)中。如需与把波形段加载到 BBG 存储介质中的相关

信息，请参阅第 71 页。

1. 选择第一个波形段:

a. 按下Mode > Dual ARB > More > More > Waveform Sequences > Build New Waveform Sequence >

Insert Waveform。

b. 突出显示所需的波形段，按下 Insert。

2. 选择第二个波形段:

a. 突出显示下一个所需的波形段，按下 Insert。

b. 按下 Done Inserting。

3. 为波形序列起一个名字，把它存储到 Seq 文件目录中:

a. 按下 More > Name and Store。

b. 输入一个文件名，按下 Enter。

另参阅: 第 76 页“查看序列的内容”，第 89 页“在波形段中设置标识点”。

波形序列

序列 A

序列 B

波形段 1

波形段 2

序列 A
重复 4 次

波形段 3

2 个波形段

9 个波形段

11 个波形段

8 个波形
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波形序列
查看序列的内容

有两种方式查看波形序列的内容，即通过 Waveform Sequences 软功能键和通过 Select Waveform 软功

能键:

通过 Waveform Sequences 软功能键

1. 按下 Mode > Dual ARB > More > More > Waveform Sequences。

2. 突出显示所需的序列。

3. 按下 ShowWaveform Sequence Contents。

通过 Waveform Select 软功能键

1. 按下 Mode > Dual ARB > Select Waveform。

2. 在 Sequence On 栏中，突出显示所需的波形序列。

3. 按下 ShowWaveform Sequence Contents。

编辑序列

在编辑波形序列时，可以:

改变每个波形段或嵌套序列播放的次数

从序列中删除波形段或嵌套序列

在序列中添加波形段或嵌套序列

切换开关标识(参阅第 95 页)

把改动保存到当前波形序列中，或另存为新序列。如果在保存改动前退出序列编辑菜单，所作的改动会丢失。

序列保存到 Seq 文件目录中。

注意 如果编辑和重新保存序列中使用的波形段，这个序列在头文件中不会自动更新 RMS 值。

必须选择和更新序列头文件信息(第 78 页)。

使用下面的步骤，编辑有两个不同波形段的序列，使第一个波形段重复 100次，第二个波形重复 200次，然

后保存所作的改动。

前提: 已经创建和存储了一个波形序列，其中有两个不同的波形段(参阅前面第 75 页的示例)。

1. 选择序列：

按下 Mode > Dual ARB > More > More > Waveform Sequences > 突出显示所需的序列

> Edit SelectedWaveform Sequence。
2. 设定第一个波形段，使其重复 100 次:

突出显示第一个波形段项目，按下 Edit Repetitions > 100 > Enter。
光标移动到下一个波形段。

3. 把选定波形段的重复次数变成 200:
按下 Edit Repetitions > 200 > Enter。

4. 保存上一步中所作的改动:
按下 More > Name 和 Store > Enter。
为把改动另存为新序列:
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波形序列
2. 生成波形:

把 ARB Off On 按到 On。

这会播放选定的波形序列。在波形序列生成过程中，I/Q 和 ARB 指示符打开，波形调制 RF 载波。

3. 配置 RF 输出:

a. 设置 RF 载频。

b. 设置 RF 输出幅度。

c. 打开 RF 输出。

现在信号发生器的 RF OUTPUT 连接器上提供了波形序列。

a. 按下 More > Name 和 Store > Clear Text。

b. 输入一个文件名 (例如, SINE100+RMP200)。

c. 按下 Enter。

编辑的序列被另存为新的波形序列。

播放序列

如果还没有创建波形序列，参阅第 75 页的“创建序列”。

注 为单独播放波形段或作为波形序列的一部分播放波形段，波形段必须存于 BBG 存储介质中。

另参阅第 71 页“把波形段加载到 BBG 存储介质(易失性存储器)中”。

1. 选择一个波形序列:

a. 按下 Mode > Dual ARB > Select Waveform。

b. 从 Sequence On 栏中，突出显示一个波形序列 (在本例中是 SINE100+RMP200)。

c. 按下 Select Waveform。

显示屏显示当前选择的波形(如 Selected Waveform: SEQ:SINE RMP )。

当有激活的波形时，指示符的显示 (ARB On)

当前选择的波形
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保存波形设置和参数

本节介绍了怎样编辑和保存头文件。在只下载波形文件(信号发生器作为波形段处理的 I/Q数据)时，信号发

生器自动生成一个头文件和一个标识文件，文件名与波形文件相同。在开始时，头文件没有保存任何信号发生器

设置，标识文件全部由零组成。对一定的波形，可以在头文件中保存信号发生器设置和参数，在标识文件中保存

标识设置(第 82 页); 在把存储的波形文件加载到 BBG 存储介质中时，头文件和标识文件设置自动应用到信号发

生器中，以便在每次播放波形文件时都以相同的方式设置双重 ARB 播放器。

图 8-5 Header Utilities 软功能键

在创建波形序列时(参阅第75页)，信号发生器自动创建一个波形序列头文件，其要优先于各个波形段头文件。

在波形序列播放过程中，会忽略波形段头文件，除非检验是否安装所有要求的选件。存储波形序列时还会存储其

头文件。

头文件中显示的部分当前信号发生器设置作为软功能键标注的一部分出现，其它设置出现在双重ARB摘要

显示屏中，如下面的示例所示。

如需每个键的详细信息，

使用第 23 页介绍的键帮助

参阅第 79 页

Mode > Dual ARB >

More > More >

Header Utilities >

ARB 摘要, 头文件设置

本菜单中的所有设置可

以存储到头文件中

软功能键标注 ,

头文件设置

软功能键标注 ,

头文件设置
78 Agilent N5181A/82A MXG 信号发生器用户指南



基本数字操作 (选件 651/652/654)
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查看和修改头文件信息

下例使用出厂时提供的波形文件 RAMP_TEST_WFM。

1. 从 BBG 存储介质中，选择波形 RAMP_TEST_WFM:

a. 按下 Mode > Dual ARB > Select Waveform。

b. 在 Segment On 栏中，突出显示波形 RAMP_TEST_WFM。

c. 按下 Select Waveform。

2. 打开 Header Utilities 菜单:

按下 More > More > Header Utilities。

图 8-6 显示了出厂时提供的波形 RAMP_TEST_WFM 的默认头文件。Header Field 栏列出了头文件参数，

使用 Page Down 键查看所有参数。

Saved Header Settings 栏显示了大多数设置 Unspecified (没有指定)。没有指定表示没有为该参数保存

任何设置。

Current Inst  Settings 栏显示了当前信号发生器设置。在本例中，这些是将保存到头文件中的设置。

注 如果在头文件中没有指定设置，那么在选择和播放波形时，信号发生器对该设置使用当前值。

图 8-6 头文件示例

3. 把 Current Inst  Settings 栏中的信息保存到头文件中:

按下 Save Setup To Header。

Saved Header Settings 栏和 Current Inst  Settings 栏现在显示相同的值; Saved Header Settings 栏列出

头文件中保存的设置。

Mode > Dual ARB > more >More > Header Utilities
波形文件的名称

描述最多可以包括 32 个字符

默认的头文件设置 当前信号发生器设置

把保存的头文件设置项

复位到默认设置
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4. 编辑和更新设置。

a. 返回 ARB Setup 菜单:

按下 Return > More > ARB Setup。

从这个菜单中，可以访问保存到头文件中的部分信号发生器设置。第69页的图8-1显示了下述步骤中使用

的 ARB Setup 软功能键。

b. 把 ARB 采样时钟设置成 5 MHz:

按下 ARB Sample Clock > 5 > MHz。

c. 把 Waveform Runtime Scaling 设为 60%:

按下 Waveform Runtime Scaling > 60 > %。

d. 返回 Header Utilities 菜单:

按下 Return > More > More > Header Utilities。

如下图所示，Current Inst  Settings栏现在反映了当前信号发生器设置变化，但Saved头文件值没有变化。

两栏的值不同

e. 把当前设置保存到头文件中:

按下 Save Setup To Header软功能键。

Current Inst  Settings 栏中的设置现在出现在 Saved Header Settings 栏中。这会把当前仪器的新设置

保存到头文件中。

如果在选择波形文件后改变头文件中列出的任何信号发生器设置，改变的设置会出现在头文件的 Current
Inst  Settings栏中，并使用改变的设置，而不是保存的头文件设置。如果想再次应用保存的头文件设置，重新选

择要播放的波形。
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在不选择波形的情况下查看和编辑头文件

如第 79页所述，可以在选择波形后查看和编辑波形的头文件信息，也可以在不选择波形的情况下编辑波形

头文件信息，或编辑与当前选择的波形不同的另一个波形的头文件信息。

1. 进入头文件辅助工具菜单:

按下 Mode > Dual ARB > More > More > Header Utilities > More > Select Different Header。

信号发生器显示存储介质中最后选择的波形文件按字母顺序排列的列表。下图显示了BBG存储介质在出厂时

提供的波形示例。

2. 如果没有显示所需的目录，选择该目录。

3. 突出显示所需的波形文件，按下 Select Header。

信号发生器显示选定的波形文件的头文件。

4. 为编辑头文件，按下 More，根据第 80 页第 4 步中的介绍继续操作(“查看和修改头文件信息”一节)。

激活目录

类型:
WFM1 = 易失性波形段

NVWFM = 非易失性波形段

SEQ = 序列

激活波形目录

激活存储介质 存储在内部或外部存储

介质中的波形序列

存储在 BBG 存储介质中的波形段

如需每个键的详细信息，

使用第 23 页介绍的键帮助

存储在内部或外部存储介质中的

波形序列
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使用波形标识

信号发生器为标记波形段的特定点提供了四个波形标识。在信号发生器遇到激活的标识时，一个辅助信号会

经由与该标识编号对应的后面板 Event 连接器输出。

Event 1 在 EVENT 1 BNC 连接器(参阅第 12 页)及 AUXILIARY I/O 连接器的针脚上(参阅第 13 页)提供。

Event 2 到 Event 4 在 AUXILIARY I/O 连接器 (参阅第 13 页)的针脚上提供。

可以使用辅助输出信号，使另一台仪器与波形同步，或作为触发信号在波形的某个点上开始测量。

还可以配置标识，引起ALC保持或RF消隐操作(其中包括ALC保持)。详情请参阅第82页“使用波形标识”。

在下载没有相关标识文件的波形文件时，信号发生器创建一个没有任何标识点的标识文件。出厂时提供的波

形段在第一个采样点上为全部四个标识提供了一个标识点。

下面的步骤演示了在双重ARB播放器中工作时怎样使用标识。这些步骤还讨论了两类点：标识点和采样点。

标识点是在波形上设置某个标识的点；可以为每个标识设置一个或多个标识点。采样点是构成波形的多个点中的

一个点。

使用波形标识的基本步骤有三个:

“从波形段中清除标识点”，第 88 页

“在波形段中设置标识点”，第 89 页

“控制波形序列中的标识”，第 95 页

本节还提供了下述信息:

“波形标识的概念”，第 83 页

“访问标识辅助工具”，第 87 页

“查看波形段标识”，第 88 页

“查看标识脉冲”，第 92 页

“使用 RF 消隐标识功能”，第 93 页

“设置标识极性”，第 94 页
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波形标识的概念

信号发生器的双重ARB为标记波形段上的特定点提供了四个波形标识。可以设置每个标识的极性和标识点

(在一个采样点上或多个采样点上)。每个标识还可以执行 ALC 保持或 RF 消隐和 ALC 保持。

标识信号响应

信号发生器把标识信号与基带发生器上的 I和 Q信号对准。但是，某些设置如RF 输出路径内部的幅度、滤

波器等等，会在标识EVENT输出信号和调制的RF输出之间产生延迟。在使用标识EVENT输出信号时，观察信

号(相对于调制的RF的标识)的任何时延，在需要时，复位标识点位置，包括延迟(第 125页)，或既进行复位、又

包括延迟。

生成标识文件

下载没有相关标识文件的波形文件(参阅编程指南)会导致信号发生器自动创建一个标识文件，但不会放置任

何标识点。

标识点编辑要求

在可以修改波形段的标识点之前，波形段必须存于BBG存储介质中(参阅第 71页“把波形段加载到BBG存

储介质(易失性存储器)中”)。

保存标识极性和路由设置

标识极性和路由设置保持不变，直到重新配置极性和预设信号发生器或重新启动。为保证波形在播放时使用

正确的设置，你应该设置标识极性或路由(RF 消隐和 ALC 保持)，并把信息保存到头文件中(第 78 页)。

注 在使用头文件中没有存储标识路由和极性设置的波形，而且以前播放的波形使用 RF 消隐时，

要保证把 RF 消隐设为 None，否则会导致达不到 RF 输出条件或波形失真。

标识

文件

第 N 位

设置标识开关 标识极性

正

负

标识N
RF 消隐开关

在标识为低

时标识 N
消隐RF

仅 RF 消隐: 包括 ALC 保持

在标识为低

时标识 N 保

持 ALC

ALC 保持开关

在信号发生器遇到打开的标识时(参阅第 95 页)，它会生成一个辅助信号，并经由后面板输出。

Event 1 在 EVENT 1 BNC 连接器(参阅第 12 页)及 AUXILIARY I/O连接器的针脚上

(参阅第 13 页)提供。

Event 2 到 Event 4 在 AUXILIARY I/O连接器 (参阅第 13)的针脚上提供。

EVENTN
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ALC 保持标识功能

虽然可以在设置标识点(第 89 页)之前或之后设置标识功能(软功能键标注上标为 Marker Routing)，但在设置

标识前设置标识功能，可能会导致在 RF 输出上出现功率尖峰或功率损失。

在波形信号带有空闲周期、突发斜坡时，或不希望在提高动态范围时遇到RF消隐功率损失(第 93页)时，应

单独使用 ALC 保持功能。

ALC保持标识功能把ALC电路保持在标识设置的采样点的平均值上。对正和负标识极性，在标识信号变高

时，ALC 对 RF 输出信号采样(载波加任何调制信号)：

正: 在标识 on 期间对信号采样。

负: 在标识 off 期间对信号采样。

注 由于它会影响波形的输出幅度，使用 ALC 保持的时间不得超过 100 ms。对更长的时间间隔，

请参阅第 48 页“功率搜索模式”。

注意 ALC 采样不正确会产生意外未调整电平的情况，可能会在 RF 输出中产生尖峰，进而可能会损坏 DUT

或连接的仪器。确保设置标识，以使 ALC 采样高于信号幅度，避免信号内出现更高电平的情况。

标识设置成考虑相对于 RF

输出的标识响应

RF 输出

标识

正极性 100 ms

最大ALC 保持时间
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错误使用的示例

波形: 1022 点

标识范围: 110-1022

标识极性: 正

本例显示了标识设为对同一波形较低的部分采样，该标识将

ALC调制器电路设置为同一电平; 在遇到高幅度的脉冲时，这通常

会给信号发生器带来未调整电平情况。

平均的特写镜头

正确使用的示例

波形: 1022 点

标识范围: 95-97

标识极性: 正

本例显示了标识设为对波形最高幅度的区域采样。注意，应在

波形最低幅度区域前设置标识。这考虑了标识和波形信号之间的任

何响应差异。

在标识信号变高前，ALC对波形采样，并使用被采样的波形的

平均值，设置 ALC 电路。

这里，ALC 在标识 on 期间(正极性)采样。

脉冲未调整电平

标识 标识
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使用不正确的示例

波形: 1022 点

标识范围: 110-1022

标识极性: 负

这个图显示了负极性标识在标识 on 期间变低; 标识信号在 off

期间变高。ALC 在标识 off 期间对波形采样。

在信号和 off 时间之间设置的负范围

同时在on期间和off期间采样会导致调制器电路对较高的信号

电平设置不当。注意在脉冲开始时的幅度提高。

采样范围从信号的第一个点开始

标识 On
标识

Off
标识 On

标识 On
标识

Off
标识

On
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使用标识辅助工具

Mode > Dual ARB > More >

注: 这是第二个

Arb 菜单。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

这些菜单中的设置可以存储到

头文件中，参阅第 78 页。

下面的显示屏显示了波形的 I、Q 两路信息，

以及出厂时提供的波形段中设置的标识点。

显示屏上

显示的

第一个采样点

这些软功能键改变了

标识显示屏上显示的

波形采样点范围。

每按一下这个软功能

键，会使采样范围改

变大约两倍。

第一个采样点

上的标识点。
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查看波形段标识

标识应用到波形段中。使用下述步骤，查看为这个波形段设置的标识(本例使用出厂时提供的波形段

SINE_TEST_WFM)。

1. 在第二个 Arb 菜单中(第 87 页)，按下 Set Markers。

2. 突出显示所需的波形段 (在本例中是 SINE_TEST_WFM)。

3. 按下 Display Waveform and Markers > Zoom in Max。

最大放大范围是 28 点。

试验 Zoom 功能，查看这些功能怎样显示标识。

显示屏可以显示最多 460 点; 如果显示的波形中的采样点范围超过 460 点，那么其可能不能显示标识位置。

从波形段中清除标识点

在设置标识点时，它们不会代替已经存在的点，而是会附加在现有点上。由于标识是累积的，因此在设置点

之前，应查看波形段(第 88页)，去掉任何不想要的点。在清除所有标识时，事件输出信号的电平是 0V。为清除

波形段上的标识点，波形段必须存于 BBG 存储介质中(第 71 页)。

清除所有标识点

1. 在第二个 Arb 菜单中(第 87 页)，按下 Set Markers。

2. 突出显示所需的波形段 (在本例中是 SINE_TEST_WFM)。

3. 突出显示所需的标识编号: 按下 Marker 1 2 3 4。

4. 对选择的标识编号，删除选择的波形段中的所有标识点:

a. 按下 Set Marker Off Range of Points。

注意第一个标识和最后一个标识的软功能键与波形长度相对应。出厂时提供的波形(SINE_TEST_WFM)

包含 200 个采样点。为清除设置的所有标识点，范围必须等于波形长度。

b. 按下 Apply To Waveform > Return。

5. 对希望从其它标识中删除的任何其余标识点，从第 3 步开始重复操作。

清除某个范围的标识点

下面的示例使用在第10-20个点中设置标识点(标识1)的波形。这样可以简便地查看受影响的标识点。不管是

在某个范围内设置现有的点，还是作为单个点设置现有的点，适用的流程相同(第 89 页)。

1. 在第二个 Arb 菜单中(第 87 页)，按下 Set Markers，然后选择 Marker 1。

2. 设置希望关闭的第一个采样点(在本例中是 13):

按下 Set Marker Off Range of Points > First Mkr Point > 13 > Enter。

3. 把希望关闭的范围中的最后一个标识点设置为小于等于波形中点数、且大于等于第 2 步中设置的值

(在本例中是 17)的值:
88 Agilent N5181A/82A MXG 信号发生器用户指南



基本数字操作 (选件 651/652/654)

使用波形标识
按下 Last Mkr Point > 17 > Enter > Apply To Waveform > Return。

这会关闭第 2 步和第 3 步中设置的

范围内激活标识的所有标识点，

如右图所示。

第 88 页介绍了怎样查看标识。

清除一个标识点

使用第 88页“清除某个范围的标识点”中介绍的步骤，但把第一个标识点和最后一个标识点都设成希望清

除的点的值。例如，如果想清除第 5 个点上的标识，把第一个值和最后一个值都设为 5。

在波形段中设置标识点

为在波形段上设置标识点，波形段必须位于 BBG 存储介质中(第 71 页)。

在设置标识点时，它们不会代替已经存在的点，而是会附加在现有点上。由于标识是累积的，因此在设置点

之前，应查看波形段(第 88 页)，去掉任何不想要的点(第 88 页)。

把标识放在某个采样点范围上

1. 在第二个 Arb 菜单中(第 87 页)，按下 Set Markers。

2. 突出显示所需的波形段。

3. 选择所需的标识编号: 按下 Marker 1 2 3 4

4. 设置范围中的第一个采样点(在本例中是 10):

按下 Set Marker On Range Of Points > First Mkr Point > 10 > Enter。

5. 把范围中最后的标识点设置成小于等于波形中点数、且大于等于第一个标识点(在本例中是 20)的值:

按下 Last Mkr Point > 20 > Enter。

6. 按下 Apply To Waveform > Return。

这会设置波形标识点的范围。标识信号从第 10 个采样点开始，在第 20 个采样点结束，如下图所示。
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第 88 页介绍了怎样查看标识。
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把标识放在一个点上

在第一个点上

1. 在第二个 Arb 菜单中(第 87 页)，按下 Set Markers。

2. 突出显示所需的波形段。

3. 选择所需的标识编号:

按下 Marker 1 2 3 4

4. 按下 Set Marker On First Point。

这会把波形段中第一个点上的标识设置成第 3 步中选择的标识编号。

在任何点上

使用第 89页“把标识放在某个采样点范围上”介绍的步骤，但把第一个标识点和最后一个标识点同时设成

希望设置的点的值。例如，如果想设置第 5 个点上的标识，那么把第一个值和最后一个值都设成 5。

放置重复间隔的标识

下面的示例在某个采样点范围内设置标识，指定每个标识之间的间隔(跳过的点数)。在应用标识设置前，必

须先设置间隔。不能对以前设置的采样点范围应用跳过的点数。

1. 删除任何现有的标识点(第 83 页)。

2. 在第二个 Arb 菜单中(第 87 页)，按下 Set Markers。

3. 突出显示所需的波形段。

4. 选择所需的标识编号:

按下 Marker 1 2 3 4

5. 设置范围中的第一个采样点(在本例中是 5):

按下 Set Marker On Range Of Points > First Mkr Point > 5 > Enter。

6. 设置范围内的最后一个标识点。(最后一个标识点的值必须一直小于等于波形中的点数、

且大于等于第一个标识点，在本例中是 25):

按下 Last Mkr Point > 25 > Enter。

7. 输入希望跳过的采样点数量(在本例中是 1):

按下 # Skipped Points > 1 > Enter。

8. 按下 Apply To Waveform > Return。

这会在标识采样点范围内每隔一个点有一个

标识(跳过一个采样点)，如右图所示。

第 88 页介绍了怎样查看标识。

跳过的点数功能的应用之一是作为

EVENT 输出创建一个时钟信号。
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使用波形标识
查看标识脉冲

在播放波形时(第 77 页)，可以在与该标识编号对应的后面板事件连接器 /Aux I/O 针脚上检测到设置和打开

的标识的脉冲。本例演示了怎样查看至少设置了一个标识点的波形段生成的标识脉冲(第89页)。波形序列的流程

与此相同。

本例在双重ARB播放器中使用出厂时提供的波形段 SINE_TEST_WFM。出厂时提供的波形段对全部 4个标

识在第一个采样点上有一个标识点，如下图所示。

第 88 页介绍了怎样查看标识。

Event 1 信号上的标识脉冲。

1. 在第一个 Arb 菜单中(第 69 页)，按下 Select Waveform。

2. 突出显示 SINE_TEST_WFM 波形段，按下 Select Waveform。

3. 按下 ARB Off On 到 On。

4. 把 Agilent MXG 的后面板 Q OUT 输出连接到示波器的通道 1 输入上。

5. 把信号发生器的后面板 EVENT 1 输出连接到示波器的通道 2 输入上。

在存在标识 1 时，Agilent MXG 通过 EVENT 1 输出一个信号，如下面的示例所示。

波形段第一个

采样点上的标

识点

RF 输出
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使用波形标识
使用 RF 消隐标识功能

尽管可以在设置标识点前或设置标位点后设置软功能键标注上的标识功能(参阅第二个Arb菜单中软功能键标

注上的Marker Routing)，但在设置标识点之前(参阅第89页)设置标识功能可能会改变RF输出。RF消隐功能包

括ALC保持能力(参阅第 84页介绍，注意与未调整电平功率有关的“注意”部分)。在标识信号变低时，信号发

生器隐去 RF 输出。本例是上一个示例“查看标识脉冲”的继续。

1. 使用出厂时提供的波形段 SINE_TEST_WFM，在第 1-180 个点中设置标识 1(第 89 页)。

2. 从 Marker Routing 软功能键菜单中，把 RF Blanking 指配给标识 1:

在第二个 Arb 菜单中(第 87 页)，按下 Marker Routing > Pulse/RF Blank > Marker 1。

RF 信号

标识极性 = 正

在标识极性为正时(默认设置)，RF输出在标识off
期间消隐。

第 1 个点
标识

波形段
180 200

≈ 3.3V

0V

第 1 个点
标识

波形段
180 200

RF 信号

标识极性 = 负

在标识极性为负时，RF输出在标识on期间消隐。

≈ 3.3V

0V
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使用波形标识
设置标识极性

设置负的标识极性会反转标识信号。

1. 在第二个 Arb 菜单中(第 87 页)，按下 Marker Polarity。

2. 对每个标识，根据需要设置标识极性。

默认的标识极性为正。

每个标识极性单独设置。

另参阅第 83 页“保存标识极性和路由设置”。

如第 93 页所示:

正极性: On 标识点为高 (≈ 3.3V)。

负极性: On 标识点为低 (0V)。

在信号较低部分会一直发生 RF 消隐，而不管极性设置如何。
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控制波形序列中的标识

在波形段中，打开的标识点生成一个辅助输出信号，这个信号路由到与该标识编号对应的后面板EVENT输

出上(参阅第9页“后面板概述”)。对波形序列，将逐个波形段打开或禁用标识，这可以为序列中某些波形段输出

标识，但不对其它波形段输出标识。除非改变序列标识设置或重新启动，否则序列中编辑的最后的波形段的标识

设置适用于构建的下一个序列中的所有波形段。如需与构建波形序列有关的信息，请参阅第 75页“创建序列”。

图 8-7 打开 / 禁用波形段标识的波形序列菜单

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

Mode > Dual ARB >
More > More >

注: 这是第三个Arb 菜单。

在创建波形序列

的同时打开 / 禁用标识

编辑序列,
打开 /禁用标识
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打开和禁用波形序列中的标识

在波形序列中选择多个波形段，单独打开或禁用每个波形段的标识。可以在创建序列时或在已经创建和存储

序列后打开或禁用标识。如果已经存储序列，在进行任何变化后，必须再次存储序列。打开没有标识点的标识对

辅助输出没有影响。为在波形段上设置标识点，请参阅第 89“在波形段中设置标识点”。本例假设存在一个波形

序列。

1. 保证序列的所有波形段都位于 BBG 存储介质中(参阅第 71 页)。

2. 从第三个 Arb 菜单中，按下 Waveform Sequence。

3. 突出显示所需的波形序列。

4. 按下 Edit Selected Waveform Sequence > Enable/Disable Markers。

5. 切换标识:

a. 突出显示第一个波形段。

b. 根据需要，按下 Toggle Marker 1, Toggle Marker 2, Toggle Marker 3 和 Toggle Marker 4。

如果 Mkr 栏中有一个项目(参阅下图)，则表明为该波形段打开了标识; 如果 mkr 栏中没有项目，

则表明该波形段的所有标识禁用。

c. 顺序突出显示每个其余的波形段，重复第 b 步。

6. 按下 Return > More > Name and Store。

7. 使用文字输入键重命名序列(参阅第 70 页)，或按下 Enter 使用现有的名称保存序列。

根据保存到序列文件中的选择结果和变化打开或禁用标识。

下图显示了使用出厂时提供的其中一个波形段构建的序列。出厂时提供的这个波形段对所有4个标识在第一

个采样点上有一个标识点。在本例中，对第一个波形段打开了标识 1，对第二个波形段打开了标识 2，对第三个

波形段打开了标识 3 和 4。

对每个波形段，只有为该波形段打开的标识会生成一个后面板辅助输出信号。在本例中，只有第一个波形段

出现标识 1辅助信号，因为其余波形段标识 1禁用。只有第二个波形段出现标识 2辅助信号，只有第三个波形段

出现标识 3 和 4 辅助信号。

序列标识栏

这一项显示了为这个波形段打

开了标识 3 和标识 4。
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使用波形标识
使用 EVENT 输出信号作为仪器触发源

EVENT 输出信号(标识信号)的用途

之一是触发测量仪器。可以设置标识，在

波形开始时、在波形中任一点上或在波形

中多个点上开始测量。为优化 EVENT 信号

在测量中的用途，可能还需要调节采样速率。

右图显示了采样速率设置的位置。

EVENT 输出信号可能会在上升沿和

下降沿上表现出最高 ± 4 ns 的抖动。

可以通过两种方式最大限度地降低这一抖动。

方法 1: 使用 125 MHz/N 的采样时钟，其中 N 是正整数，且能够在显示屏上精确地表示 125 MHz/N。例如:

125 MHz, 62.5 MHz, 31.25 MHz, 25 MHz 等等。

如果在显示屏上不能精确地表示结果，那么存在抖动。例如: N = 6会产生抖动，因为，在显示时会被截短。

方法 2: 选择采样时钟和标识间隔是 8 ns 倍数的波形长度。例如: 200 点波形、且标识在第一个采样点及 50

MHz的采样时钟会每隔 4 µs提供一个标识。 由于 4 µs是 8 ns的倍数，因此最大限度地降低了抖动。

在EVENT输出信号表现出抖动，并作为测量触发使用时，其可能会导致波形错误地表现为有抖动。如果发

生这种情况，可以把采样速率调节到不会导致出现抖动的值(参阅上面)。为在采样速率变化时保持原始波形的完

整性，还必须重新计算采样值。下图说明了标识信号抖动及其对波形的影响。

如需每个键的详细信息，使用第23页介绍的帮助键。

采样

速率

设置

这个菜单中的设置

可以存储到头文件

中，参阅第 78 页。

示波器触发 EVENT 信号

EVENT 输出信号表明了由于采

样速率没有优化而出现的抖动

示波器触发波形

在使用带有抖动的 EVENT 信

号触发时, 波形表明了抖动

示波器触发 EVENT 信号

使用优化的采样速率时,
抖动消失
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触发波形
触发波形

图 8-8 触发软功能键

通过控制信号发生器什么时候发送调制信号，触发控制着数据传输。可以配置触发设置，以便数据传输发生

一次(单次模式)、连续发生(连续模式)或重复开始和结束(选通和段提前触发模式)。

触发信号同时包含正状态和负状态；可以使用任一状态触发。

在初始选择触发模式时或在从一种触发模式变成另一种触发模式时，可能会丢失RF输出上的载波信号，直

到触发调制信号。这是因为信号发生器在第一个触发事件前把 I和Q信号设为零伏。为在RF输出上保持载波信

号，应使用设置为零值之外的其它值的初始 I 和 Q 电压创建数据码型。

配置波形触发分成两个部分:

类型决定着播放时的波形行为(参阅触发类型，第 99 页)。

来源决定着信号发生器怎样接收开始播放调制波形的触发(参阅触发源，第 100 页)。

Mode > Dual ARB >

参阅第 99 页

查看

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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触发波形
触发类型

类型定义了触发模式，即在触发时怎样播放波形。

连续模式重复波形，直到关闭信号或选择不同的波形、触发模式或响应(自由运行, 触发和运行, 复位和运行)。

单次模式播放波形一次。

段提前触发模式只在触发时播放序列中的波形段。触发源控制着波形段之间的播放(参阅示例: 段提前触发，第

101 页)。在最后一次波形段循环中收到的触发会播放到序列中的第一个波形段。

选通模式在第一个激活的触发状态上触发波形，然后重复开始和停止播放波形，以响应外部应用的选通信号。

参阅示例: 门选通触发，第 102 页。

序列中的波形段连续播放, 直到波形收到另一个触发。

如果在播放波形段时收到触发, 波形段播放直到完成。然

后双重ARB播放器进入下一个波形段, 连续播放该波形段。
如需每个键的详细信息,
使用第 23 页介绍的帮助键。

Mode >
Dual ARB >
Trigger Type >

立即触发和播放波形; 在播放波形时忽略收到的触发。

在收到触发时播放波形; 忽略后续触发。

在收到触发时播放波形; 后续触发重启波形。

在触发源处于不激活状态期间, 波
形停止; 在激活期间播放波形。

播放序列中的波形段一次,
忽略重复设置 ,  然后双重

ARB播放器停止, 等待触发,
然后进入下一个波形段。然

后播放下一个波形段, 直到

完成。

如果在播放波形段时收到触

发, 波形段会播放直到完成。

然后双重 ARB 播放器进入

下一个波形段, 播放该波形

段直到完成。

在播放波形时忽略收

到的触发。

在播放波形时收到的

触发等到当前波形结

束, 然后再一次播放

波形。

在播放波形时收到的

触发立即重启波形。
99Agilent N5181A/82A MXG 信号发生器用户指南



基本数字操作 (选件 651/652/654)

触发波形
触发源

外部触发极性

在连续模式、单次模式和段提前触发模式下，使用 Ext Polarity 软功能键，设置外部触发极性。

在选通模式，Active Low 和 Active High 软功能键 (第 99 页) 决定外部触发极性。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

Mode >
Dual ARB >
Trigger Source >

Patt Trig In BNC连接器

(参阅第 13 页)

Aux I/O 连接器 (参阅第 13 页)

Neg = 信号发生器在触发信号

为低状态期间响应。

Pos = 信号发生器在触发信号

为高状态期间响应。
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触发波形
示例: 段提前触发

通过段提前触发，可以控制波形序列内部的波形段。这种触发忽略重复值(第76页)。例如，如果波形段的重

复次数是50，选择Single作为段提前触发模式，那么波形段仍会只播放一次。下面的示例使用带有两个波形段的

波形序列。

如果还没有创建和存储波形序列，参阅第 75 页“创建序列”。

1. 预设信号发生器。

2. 配置 RF 输出:

设置所需的频率。

设置所需的幅度。

打开 RF 输出。

3. 选择播放的波形序列：

a. 按下 Mode > Dual ARB > Select Waveform。

b. 在 Sequence On 栏中，突出显示波形序列文件。

c. 按下 Select Waveform。

4. 设置触发如下:

触发类型: 连续段提前触发

按下 Trigger Type > Segment Advance > Continuous。

触发源: Trigger 硬功能键

按下 Trigger Source > Trigger Key。

5. 生成波形序列:

按下 ARB Off On，直到 On 突出显示。

6. (可选) 监测波形:

把信号发生器的 RF OUTPUT 连接到示波器的输入上，配置示波器，以便能够查看信号。

7. 触发第一个波形段，开始连续播放波形：

按下 Trigger 硬功能键。

8. 触发第二个波形段：

按下 Trigger 硬功能键。

按下 Trigger 硬功能键，导致当前播放的波形段结束，下一个波形段开始。

如果正在播放序列中最后的波形段，按下 Trigger 硬功能键会导致最后一个波形段结束时波形序列中的

第一个波形段开始播放。
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触发波形
示例: 门选通触发

通过门选通触发，可以定义调制波形的开关状态。

1. 把函数发生器的输出连接到信号发生器的后面板 ATT TRIG IN 连接器上，如下图所示。这一连接适用于

所有外部触发方法。通过选装示波器连接，可以查看触发信号对 RF 输出的影响。

2. 预设信号发生器。

3. 配置 RF 输出:

设置所需的频率。

设置所需的幅度。

打开 RF 输出。

4. 选择要播放的波形(序列或段):

a. 按下 Mode > Dual ARB > Select Waveform。

b. 在 Segment On 或 Sequence On 栏中, 突出显示一个波形。

c. 按下 Select Waveform。

5. 设置触发如下:

触发类型: 门选通触发

按下 Trigger Type > Gated。

激活状态: 低

按下 Active Low。

触发源: 外部

按下 Trigger Source > Ext。

输入连接器: 后面板 Patt Trig In BNC

按下 Ext Source > Patt Trig In 1。

6. 生成波形: 按下 Return > ARB Off On，直到 On 突出显示。

函数发生器

信号发生器 示波器

RF 输出

PAT TRIG

通道 1
通道 2
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触发波形
7. 在函数发生器上，为外部触发配置一个 TTL 信号。

8. (可选)监测波形:

配置示波器，同时显示信号发生器的输出和外部触发信号。在选通激活期间可以看到调制输出的波形

(本例中下方所示)。

下图是显示屏示例。
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触发波形
示例: 外部触发

使用下面的示例设置信号发生器，在 PATT TRIG IN后面板BNC连接器上发生从低到高的TTL状态变化后

100 毫秒时，输出一个被调制的 RF 信号。

1. 把信号发生器连接到函数发生器上，如上图所示。

2. 配置 RF 输出:

设置所需的频率。

设置所需的幅度。

打开 RF 输出。

3. 选择要播放的波形 (序列或波形段):

a. 按下 Mode > Dual ARB > Select Waveform。

b. 在 Segment On 或 Sequence On 栏中，突出显示一个波形。

c. 按下 Select Waveform。

4. 生成波形:

按下 ARB Off On，直到 On 突出显示。

5. 设置波形触发如下:

a. 触发类型: 单次

按下 Trigger Type > Single > No Retrigger。

b. 触发源: 外部

按下 Trigger Source > Ext。

c. 输入连接器: 后面板 Patt Trig In BNC

按下 Ext Source > Patt Trig In 1。

d. 外部触发极性: 正

按下 Ext Polarity，直到 Pos 突出显示。

e. 外部延迟: 100 ms

按下 More > Ext Delay，直到 On 突出显示。

按下 Ext Delay Time > 100 > msec。

6. 配置函数发生器:

波形: 0.1 Hz 方波

输出电平: 3.5V - 5V

函数发生器

信号发生器 输出

PAT TRIG
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波形削减
波形削减

带有高功率峰值的数字调制的信号可能会导致互调失真，进而导致频谱再生，干扰相邻频段中的信号。削减

功能可以把 I/Q 数据削减到最高峰值的选定百分比，降低高功率峰值，进而减少频谱再生。

功率峰值是怎样形成的，第 106 页

峰值怎样导致频谱再生，第 108 页

削减怎样降低峰值平均功率比，第 109 页

配置圆形削减，第 112 页

配置矩形削减，第 113 页

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

图 8-9 削减软功能键

Mode > Dual ARB > More > More >

只有在削减类型 =

|I| , |Q| 时才能使用
105Agilent N5181A/82A MXG 信号发生器用户指南



基本数字操作 (选件 651/652/654)

波形削减
功率峰值是怎样形成的

为查看削减怎样降低高功率峰值，最好了解在构建信号时峰值是怎样形成的。

多条通道加总

I/Q波形可以是多条通道加总的结果，如下图所示。如果同一种状态(高或低)的比特同时发生在多条单独通道

的波形中，在加总的波形中通常会发生异常高的功率峰值(正或负)。

由于通道波形中的高状态和低状态比特是随机的，一般会导致抵消效应，因此在多通道加总中很少发生高功

率峰值。

加总的 I 或 Q 波形

多条通道加总到一个I

或 Q 波形
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波形削减
I 波形和 Q 波形组合

当 I 波形和 Q 波形在 I/Q 调制器中组合创建 RF 波形时，RF 包络的幅度是   I2 + Q2，其中 I 和 Q 的平方一直

得到正值。

如下图所示，I波形和Q波形中同时出现正峰值和负峰值相互不能抵消，而会组合在一起，产生更大的峰值。

组合的 I 波形和 Q 波形

高峰值的矢量表示
得到的基带波形

公式:   I2 + Q2

I

Q

4 V

-4 V

5.66 V

Ｑ

Ｉ

5.66    -4V

4 V
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基本数字操作 (选件 651/652/654)

波形削减
峰值怎样导致频谱再生

在波形中，发生不频繁的高功率峰值会导致波形有很高的峰值平均功率比，如下图所示。

平均功率

相邻频段

由于发射机的功放器增益设置成提供某个平均功率，因此高峰值可能会导致功放器转向饱和。这会导致互调

失真，产生频谱再生。频谱再生是在载波每一侧形成的一个频率范围(类似于边带)，并扩展到相邻的频段中(参阅

下图)。通过降低峰值平均功率比，削减为解决这个问题提供了解决方案。

峰值功率

频谱再生

RF 信号
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波形削减
削减怎样降低峰值平均功率比

可以通过波形削减降低峰值平均功率比，进而减少频谱再生。削减通过把 I数据和Q数据削减到最高峰值的

选定百分比，来限制波形功率峰值。信号发生器提供了两种削减方法:

圆形削减应用到合成 I/Q数据中(I和 Q数据同等削减)。如图 8-10所示，削减电平对所有矢量相位恒定不变，

在矢量表示中表现为一个圆。

矩形削减独立应用在 I 数据和 Q 数据中。

如第 110 页图 8-11 时所示，削减电平对 I 和 Q 不同，在矢量表示中表现为一个矩形。

在圆形削减和矩形削减中，其目标都是把波形削减到一定程度，可以降低频谱再生，而又不会破坏信号完整

性。第 111 页图 8-12 中的两个互补累积分配曲线显示了在对波形应用圆形削减后峰值平均功率比下降。

削减值越低，传送的峰值功率越低(削掉的信号越多)。通常可以削掉峰值，而不会明显干扰波形的其余部分。

在许多情况下，由于编码系统中固有的纠错能力，可以保留削减过程中可能会丢失的数据。但是，如果应用的削

减过多，可能会不能恢复丢失的数据。应试着改变削减设置，找到既能减少频谱再生、又能保留所需数据的削减

百分比。

图 8-10 圆形削减

没有削减的峰值功率

(削减设置为 100%)

削减设置为 80%

削减后的基带波形

削减后的峰值的矢量表示

4.53 V

Q

I
4.53V
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波形削减
a) |I| 削减设置为 100%(没有削减)

b) |I| 削减设置为最大峰值的 75%

c) |Q| 削减设置为 100%(没有削减)

d) |Q| 削减设置为最大峰值的 50%

图 8-11 矩形削减

削减后的 I 波形

削减后的I和Q峰值的矢量表示

削减后的 Q 波形

Ｉ

Ｑ

3 V

2 V

a
b

d

c

Q

I

b

a

c
d

3 V

2 V
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基本数字操作 (选件 651/652/654)

波形削减
图 8-12 降低峰值平均功率比

CCDF, 削减 =100%(没有削减)

CCDF, 削减 =80%

互补累积分配曲线
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波形削减
配置圆形削减

使用本例配置圆形削减，观察其对波形峰值平均功率比的影响。圆形削减会削掉合成 I/Q数据 (I和Q数据同

等削减)。如需与圆形削减有关的更多信息，请参阅第 109 页“削减怎样降低峰值平均功率比”。

注意 削减是不可逆的、累积的。在应用削减前应保存波形文件拷贝。

复制波形文件

1. 显示信号发生器的文件: 按下 File > Catalog Type > More > Volatile Segments。

2. 突出显示波形 RAMP_TEST_WFM。

3. 按下 Copy File。

4. 给拷贝起名字(在本例中名字是 MY_TEST_CIRC)，按下 Enter。

对复制的波形文件应用圆形削减

1. 打开 DUAL ARB Waveform Utilities 菜单: 按下 Mode > Dual ARB > More > More > Waveform Utilities。

2. 在文件列表中，突出显示复制的文件 (在本例中是 MY_TEST_CIRC)。

3. 创建 CCDF 曲线: 按下 Plot CCDF。

4. 观察波形曲线的形状和位置

(右面示例的黑色)。

5. 激活圆形削减: 按下

Return > Clipping > Clipping Type，

直到 |I+jQ| 突出显示。

6. 把圆形削减设置为 80%:

按下 Clip |I+jQ| To > 80 > %。

7. 对 I 和 Q 数据应用 80% 削减:

按下 Apply to Waveform。

8. 创建 CCDF 曲线 (参阅右面的示例):

按下 Plot CCDF。

9. 观察削减后的波形曲线。

注意峰值平均功率比较

上一个图下降。

削减前的波形曲线示例

圆形削减后的波形曲线示例
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波形削减
配置矩形削减

使用本例配置矩形削减。矩形削减独立削掉 I数据和Q数据。如需与矩形削减有关的更多信息，请参阅第109

页“削减怎样降低峰值平均功率比”。

注意 削减是不可逆的、累积的。在应用削减前应保存波形文件拷贝。

复制波形文件

1. 显示信号发生器的文件: 按下 File > Catalog Type > More > Volatile Segments。

2. 突出显示波形 RAMP_TEST_WFM。

3. 按下 Copy File。

4. 给拷贝起名字(在本例中名字是 MY_TEST_REC)，按下 Enter。

对复制的波形文件应用矩形削减

1. 打开 DUAL ARB Waveform Utilities 菜单: 按下 Mode > Dual ARB > More > More > Waveform Utilities。

2. 在文件列表中，突出显示复制的文件 (在本例中是 MY_TEST_REC)。

3. 创建 CCDF 曲线: 按下 Plot CCDF。

4. 观察波形曲线的形状和位置

(右面示例的黑色)。

5. 激活矩形削减:

按下 Return > Clipping > Clipping Type，

直到 |I|,|Q| 突出显示。

6. 为 I 数据设置 80% 削减:

按下 Clip |I| To > 80 > %。

7. 为 Q 数据设置 40% 削减:

按下 Clip |Q| To > 40 > %。

8. 对波形应用矩形削减:

按下 Apply to Waveform。

9. 创建 CCDF 曲线 (参阅右面的示例):

按下 Plot CCDF。

10. 观察削减后的波形曲线。

注意峰值平均功率比较上一个图下降。

削减前的波形曲线示例

矩形削减后的波形曲线示例
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幅值缩放波形
幅值缩放波形

信号发生器使用内插算法(在 I/Q数据点之间采样)重建波形。对常用波形，这种内插可能会导致过冲，过冲

可能会产生DAC超出范围错误的情况。本章介绍了DAC超出范围错误是怎样发生的，及怎样使用波形幅值缩放

消除这些错误。

DAC 超出范围错误是怎样发生的，第 116

幅值缩放怎样消除 DAC 超出范围错误，第 117

Agilent MXG 波形幅值缩放，第 118 页和第 119 页:

—  波形运行时幅值缩放，确定当前播放的波形标度

—  波形幅值缩放，永久确定当前播放的波形或 BBG 存储介质中没有播放的波形文件的标度
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幅值缩放波形
图 8-13 幅值缩放软功能键

如需每个键的详细信息,

使用第 23 页介绍的帮助键。

波形幅值缩放, 参阅第119页

波形运行时幅值缩放, 参阅第 118

这个菜单中的设置可以存储

到头文件中, 参阅第 78 页
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幅值缩放波形
DAC超出范围错误是怎样发生的

在把数字I和Q基带波形转换成模拟

波形时，信号发生器使用内插滤波器。

由于内插器的时钟速率是基带时钟的四

倍，因此内插器会计算进入的基带采样

点之间的采样点数量，平滑波形，如右

图所示。

DAC中的内插滤波器会过冲基带波

形。如果基带波形有一个快速上升沿，

那么内插滤波器的过冲会变成内插的基

带波形的一部分。这种响应会在上升沿

峰值上导致纹波波动或振铃效应。如果

这个纹波波动过冲DAC范围上限，那么

内插器会计算错误的采样点，不能复现

纹波波动的真正形状(参阅右图)。结果，

信号发生器会报告发生 DAC 超出范围

错误。

内插的采样点

基带采样点

超出范围的采样点

不能正确内插

D
A

C
范

围

基带采样点
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幅值缩放波形
幅值缩放怎样消除 DAC 超出范围错误

幅值缩放降低了基带波形的幅度，同时保持其

基本形状和特点，如峰值平均功率比。如果对快速

上升的基带波形进行充分幅值缩放，以保证为内插

滤波器过冲提供充足的余量，那么内插滤波器可以

计算包括纹波波动效应在内的采样点，消除超出范

围错误(参阅右图)。

尽管幅值缩放保持波形的基本形状，但幅值缩

放过度会破坏波形完整性。例如，如果比特分辨率

变得太低，量化噪声会破坏波形。为实现最大精度

及优化动态范围，波形幅值缩放的程度不得超过消

除DAC超出范围错误所要求的程度。最优幅值缩放

会随着波形内容变化。

DAC 范围内的

采样点正确内插

D
A

C
范

围

基带采样点
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幅值缩放波形
设置波形运行时幅值缩放

运行时幅值缩放在播放过程中缩放波形数据，不影响存储的数据。可以对波形段或序列应用运行时缩放，在

ARB打开或关闭时设置缩放值。这种缩放类型特别适合消除DAC超出范围错误。运行时缩放调节不能累积；缩

放值应用到波形文件的原始幅度。有两种方式保存运行时缩放设置: 一种方式是使用保存功能(第35页)，另一种

方式是把设置保存到头文件中(第 79 页)。在保存到头文件中时，缩放值会与波形文件一起保存; 在使用 Save 功

能保存时，会把缩放值存储为当前仪器设置。

使用本例了解怎样缩放当前选择的波形。

1. 选择希望应用幅值缩放的波形:

a. 按下 Mode > Dual ARB > Select Waveform。

b. 突出显示所需的波形(段或序列)。

c. 按下 Select Waveform。

2. 播放选择的波形: 按下 ARB Off On，直到 On 突出显示。

3. 设置波形运行时幅值缩放值:

a. 按下 ARB Setup > Waveform Runtime Scaling。

b. 输入幅值缩放值。

信号发生器对波形自动应用新的幅值缩放值。没有哪一个最优值会适用于所有波形。

为实现最大动态范围，应使用不会产生 DAC 超出范围错误的最大幅值缩放值。

c. 按下 Return。
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幅值缩放波形
设置波形幅值缩放

波形幅值缩放与波形运行时幅值缩放的区别在于，它永久影响波形数据，且只适用于BBG存储介质中存储

的波形段。可以作为DAC全标(100%)的百分比向上或向下幅值缩放波形。如果使用这种方法缩放波形，可能还

需要改变波形运行时缩放值，以适应这种标度。

在幅值缩放时，信号发生器永久修改波形文件的采样点值，以便符合所需的幅值缩放值。在初始设定幅值缩

放时，信号发生器执行下述操作:

定位波形文件的绝对峰值采样点值

确定当前设置占全标的百分比

计算所需幅值缩放值与确定的绝对峰值采样点标度值的比率

把波形文件中的每个采样点乘以这个比率

幅值缩放后的采样点值 = 幅值缩放比率×幅值缩放前采样点值

幅值缩放比率 = 所需的标度值 / 当前标度值

= 60 / 85

= 0.70588

波形中的每个采样点乘以 0.70588，得出 60% 幅值缩放后波形幅度。

在幅值缩放波形时，可能会产生小数点数据，丢失数据，或这两种情况同时出现。几乎在每次降低或提高标

度值时，都会出现小数点数据，导致量化误差。在向下幅值缩放时量化误差要更加明显，因为更靠近本底噪声。

在信号发生器对小数点数据四舍五入或使用2的幂数得到的结果来推导标度值时，会丢失数据。也就是说，对半

个波形幅值缩放(2 的幂数: 21 = 2)会导致每个波形采样点丢失一个比特。波形数据修改是不能校正的，可能会导

致波形失真。在应用幅值缩放前，最好复制原始文件。

使用下述示例对波形文件应用波形幅值缩放。本流程使用出厂时提供的波形RAMP_TEST_WFM，但任何波

形文件均采用相同的流程。

复制波形文件

1. 显示 BBG 存储介质中的波形文件: 按下 File > Catalog Type > More > Volatile Segments。

2. 突出显示波形 RAMP_TEST_WFM。

3. 按下 Copy File。

峰值采样

DAC 全标 100%

85%的全标-幅值缩放前

60%的全标 - 幅值缩放后

● = 采样点

原始锯齿波形 幅值缩放后的锯齿波形
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幅值缩放波形
4. 给拷贝起一个名字(本例使用名字 MY_TEST_SCAL)，按下 Enter。

对复制的波形文件应用幅值缩放

注意 这种幅值缩放操作是不可逆的。不能恢复幅值缩放操作中丢失的任何数据。

在应用幅值缩放前应保存波形文件拷贝。

1. 打开 DUAL ARB Waveform Utilities 菜单:

按下 Mode > Dual ARB > More > More > Waveform Utilities。

2. 在 BBG Media segment 文件列表中，突出显示复制的文件(在本例中是 MY_TEST_SCAL)。

3. 设置和应用幅值缩放值(在本例中应用 70% 幅值缩放):

按下 Scale Waveform Data > Scaling > 70 > % > Apply to Waveform。
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I/Q 调制
I/Q 调制

下述因素影响着误差矢量幅度:

I 通道和 Q 通道之间的幅度、相位和延迟差

直流偏置

通过 I/Q 菜单，不仅可以选择 I/Q 信号源和输出，还提供了调节和校准功能，补偿 I 信号和 Q 信号差异。

另参阅第 34 页“调制载波信号”。

图 8-14 I/Q 显示屏和软功能键

每条路径要求不同的优化值; 在选择一条路

径时，会同时选择该路径要求的唯一的优

化值。

信号发生器会把选择的优化值同时应用到

两条路径中，这会劣化没有选择的路径。

这个面板显示了I/Q信号路由

和为I/Q校正作过优化的路径

的当前设置。

这个面板显示了 I/Q 调节的当前状态和设

置。使用 Page Up 键和 Page Down 键，

滚动这些参数。灰色表示调节功能未

被激活(关闭)。

第 125 页

第 127 页

这些选择体现在I/Q

路由和优化图中。

反转内部生成的 Q 信号，使得 I 分量

滞后 Q 分量 90 度。

只用于内部生成的突发的调制格式。

打开 / 禁用 RF 突发调制器。

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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基本数字操作 (选件 651/652/654)

I/Q 调制
使用后面板 I和 Q输出

注 后面板 I 和 Q 连接器只在使用内部 BBG 时才输出信号。

除调制载波外，信号发生器还把内部生成的 I和Q信号路由到后面板 I和Q连接器。这些输出信号位于DAC

后面，因此为模拟信号。可以使用这些后面板 I 和 Q 信号:

驱动系统的发射机

测试模拟 I/Q 器件，如 I/Q 调制器

把 I 和 Q 信号路由到另一个信号发生器中

出厂时默认的设置把内部生成的 I 和 Q信号路由到 I/Q 调制器及后面板 I和 Q 输出连接器上。但是，为优化

(应用校准系数)后面板信号，必需选择外部 I/Q 输出路径。

选择和播放波形

1. 按下 Mode > Dual ARB > Select Waveform。

2. 突出显示所需的波形。

3. 按下 Select Waveform > ARB Off On 到 On。

优化信号路径

1. 把电缆从后面板 I 和 Q 连接器连接到 DUT 或另一台信号发生器上。

在打开 ARB 时，信号发生器自动把 I 和 Q 信号输出到后面板连接器。

可以使用后面板 I 和 Q 信号作为到另一台信号发生器的 I 和 Q 输入。

MXG 带有用于这一功能的前面板 I 输入和 Q 输入连接器。

2. 按下 I/Q > I/Q Correction Optimized Path > Ext I/Q Output。
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基本数字操作 (选件 651/652/654)

I/Q 调制
优化过的后面板 I/Q 路径

在优化路径时，路径指示变成绿色。

出厂时默认的设置 - 优化了 RF 输出路径
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基本数字操作 (选件 651/652/654)

I/Q 调制
配置前面板输入

信号发生器通过前面板 I输入和Q输入接受外部提供的模拟 I和Q信号。可以使用外部信号作为调制源，或

把外部信号与内部基带发生器信号相加。

1. 把 I 和 Q 信号连接到前面板连接器上。

a. 把一个模拟 I 信号连接到信号发生器的前面板 I 输入上。

b. 把一个模拟 Q 信号连接到信号发生器的前面板 Q 输入上。

2. 设置信号发生器，识别前面板输入信号:

调制到载波上

按下 I/Q > I/Q Source > External。

加总并调制到载波上

按下 I/Q > I/Q Source > Sum。

如果想为 BB GEN 路径选择和播放一个波形，参阅第 71 页

信号发生器显示屏 - 两条路径都进行了校准，

其中 I/Q Correction Optimized Path 设置为

Ext I/Q Output (参阅第 122页)。

信号发生器显示屏-其中两条RF路径都进行了校

准，其中 I/Q Correction Optimized Path 设置

为 RF Output (参阅第 122页)。

注意只有内部 BBG (BB GEN)把 I 和 Q 信号路由到后面板 I 和 Q 输出上。

3. 如果只使用外部 I 和 Q 信号(没有加总)，打开 I/Q 调制器:

按下 I/Q Off On 到 On。

4. 配置 RF 输出:

a. 设置载频。

b. 设置载波幅度。

c. 打开 RF 输出。
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基本数字操作 (选件 651/652/654)

I/Q 调制
偏移一般用来产生劣化，或降低带宽很宽的信号的

误差矢量。

提供 I信号和Q信号之间的相对时延校正。I信号和

Q 信号使用不同的信号路径传送，会导致时延差

异，这在大带宽调制信号中表现为 EVM 误差。

在基带产生时在 I/Q信号中增加相等但相反的时延

(偏移)，可以消除时延误差，校正内部基带发生器

生成的信号中的任何延迟。

I/Q 调节

使用 I/Q 调节补偿 I/Q 信号中的劣化或在 I/Q 信号中增加劣化。

I/Q > I/Q Adjustments >

相对于Q信号幅度调节 I信号幅度。使

用它作为内部劣化，或补偿由于外部 I

和 Q 输出电缆中路径不规则导致的信

号路径损耗差异。

只在选装

1EL 选件时

才能使用

相对于I信号偏移Q信号的

相位。校准基带正交调节

键的单位为度。外部输入

正交调节没有经过校准。

这个键提供的功能与 I/Q

Skew (I/Q 偏移) 键提供

的功能不同。

根据触发和标识同时改变I信号和Q信号的

绝对相位。

正值增加延迟，负值使信号提前。这个值同

时影响调制到 RF 上的基带信号和外部输

出信号(I和 Q)。这一设置不能在恒定包络

调制上使用，也不影响外部 I和Q的输入。

只有在播放波

形时才能使用。偏置一般用来降低载波泄漏或产生用来

仿真载波泄漏的劣化。

共模 I/Q偏置

同时调节 I 信号和 Q 信号的直流偏置。

差模 I偏置

调节 I和 I-bar 输出信号的直流偏置电平。

不能单独调节 I和 I-bar。

差模 Q偏置

调节 I和 I-bar 输出信号的直流偏置电平。

不能单独调节 I和 I-bar。
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基本数字操作 (选件 651/652/654)

I/Q 调制
I/Q 调节 影响 劣化

偏置 载波馈通 直流偏置

正交角
EVM 误差 相位偏移

I/Q 镜像 I/Q 路径延迟

I/Q 偏移 EVM 误差
高采样速率相位

偏移或 I/Q 路径延迟

I/Q 增益平衡 I/Q 幅度差 I/Q 增益比

表 8-1 I/Q 调节的用途

I/Q调节、I/Q延迟不能用来增加劣化程度; 其功能是补偿EVENT输出信号(标识信号)与RF输出之间的任何

时延。
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基本数字操作 (选件 651/652/654)

I/Q 校准
I/Q 校准

使用 I/Q校准进行 I和Q信号校正。校正 I和Q信号的哪些指标取决于信号是内部生成的、还是外部生成的。

校正 内部 I 和 Q 外部 I 和 Q

偏置 X X

增益平衡 X --

正交误差 X X

在执行 I/Q校准时，该校准数据优先于出厂时提供的校准数据。校准程序改善了可能会随着时间推移或温度

变化而劣化的性能。

DC针对当前仪器设置优化 I/Q性能，一般会在几秒内完成。在执

行DC校准后，改变任何仪器设置(除 I/Q调节外)都会使DC校准

失效，导致信号发生器恢复到出厂时提供的校准数据。

预设仪器或重新启动相当于按下Revert to Default Cal Setting。

User在不要求全面校准时提供了更快的校准速度。通过指定校准

开始频率和结束频率，可以限定校准。

在把校准限定在小于仪器的整个频率范围时，范围的其余部分会

使用出厂时提供的校准数据。

在预设或重新启动时会保留信息。

Full 需要 5 分钟在仪器的整个频率范围上执行测量。

在预设或重新启动时会保留信息。

I/Q > I/Q Calibration >

只有在 Calibration

type = User 时才能使用

删除用户生成的任何校准

数据，恢复出厂时提供的

校准数据。

如需每个键的详细信息,

使用第 23 页介绍的帮助键。
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I/Q 校准



在使用这些信息前，应该已经熟悉信号发生器的基本操作。如果不熟悉设置功率电平和频率等功能，请参阅

第 23 页第 3 章“基本操作”，熟悉该章中的信息。

本章介绍了使用附加白高斯噪声(AWGN)波形发生器的示例，AWGN只能用于带有选件403的矢量信号发生

器中。

“在双重 ARB 波形中增加实时噪声”，第 130 页

“使用实时 I/Q 基带 AWGN”，第 132 页

9   在信号中增加实时噪声 (选件 403)
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在信号中增加实时噪声

在双重 ARB 波形中增加实时噪声
在双重 ARB波形中增加实时噪声

带有选件 403 的矢量信号发生器可以在双重 ARB 波形播放器中播放调制的波形的同时，向载波上附加白高

斯噪声(AWGN)。

图 9-1 实时 I/Q基带 AWGN软功能键

实际噪声带宽，一般略

宽于载波带宽。

如需每个键的详细信息,

使用第 23 页介绍的帮助键。

显示屏上显示了噪声状态(开或关)。

载波功率比上噪声功率的值。

对选定的载波噪声比，对噪

声求积分的带宽。
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在信号中增加实时噪声

在双重 ARB 波形中增加实时噪声
通过下述步骤，使用出厂时提供的波形 SINE_TEST_WFM 调制 1 GHz, -10 dBm 载波，然后应用 45 MHz 带

宽噪声，其在 40 MHz 载波带宽上拥有 30 dB 的噪声功率的载波与噪声比。

1. 预设信号发生器，设置如下:

频率: 1 GHz

幅度: -10 dBm

RF 输出: 打开

2. 选择出厂时提供的波形 SINE_TEST_WFM:

a. 按下 Mode > Dual ARB > Select Waveform。

b. 突出显示 SINE_TEST_WFM，按下 Select Waveform。

3. 打开双重 ARB 播放器: 按下 ARB Off On，突出显示 On。

4. 把 ARB 采样时钟设置为 50 MHz: 按下 ARB Setup > ARB Sample Clock > 50 > MHz。

5. 按下 Real-time Noise Setup，设置如下:

载波噪声比: 30 dB

载波带宽: 40 MHz

噪声带宽: 45 MHz

实时噪声: 打开

信号发生器显示的功率电平(-10 dBm)包括噪声功率。
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在信号中增加实时噪声(选件 403)

使用实时 I/Q 基带 AWGN
使用实时 I/Q基带 AWGN

图 9-2 实时 I/Q基带 AWGN软功能键

使用下述步骤，对 500 MHz, -10 dBm 载波应用 10 MHz 带宽噪声。

1. 设置噪声:

a. 预设信号发生器。

b. 按下 Mode > Real Time I/Q Baseband AWGN。

c. 按下 Bandwidth > 10 > MHz。

2. 生成噪声:

按下 AWGN Off On，

直到 On 突出显示。

在生成期间，AWGN 和 I/Q 指示

符激活(如右图所示)。AWGN

现在可以用来调制 RF 载波。

3. 配置 RF 输出:

频率: 500 MHz

幅度: -10 dBm

RF 输出: 打开

信号发生器的 RF OUTPUT 连接器上现在可以输出附加 AWGN 的载波。

如需每个键的详细信息,

使用第 23 页介绍的帮助键。
132 Agilent N5181A/82A MXG 信号发生器用户指南



了解存储器类型，第 134 页

从存储器中删除数据 (仅适用于选件 006)，第 136 页

使用安全显示 (仅适用于选件 006)，第 139 页

10   在安全环境中工作
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在安全环境中工作

了解存储器类型
存储器 用途 / 内容 数据输入方法 在仪器中的位置及备注

类型和

容量

主存储器 是 否 运行固件的存储器 操作系统 CPU 电路板

(RAM) 没有用户数据

32 MB

主存储器 是 是 出厂校准 /配置数据a 固件升级和用户 CPU 电路板(与固件存储器使用相同的芯片，

(闪存)  用户文件系统，其 保存的数据 a 但单独管理)

8 MB 中包括平坦度校准、 由于这个存储器芯片包含 8MB 的用户数据

仪器状态和扫描列表 (这里介绍)及 8MB 的固件存储器，因此最好

不要擦除整个芯片。在执行Erase and Sanitize

功能时，可以选择性地全面清除用户数据区域。

固件存储器 否 是 主要固件镜像 出厂时安装或 CPU 电路板

(闪存) 固件升级 (与固件存储器使用相同的芯片，但单独管理)

8 MB 在正常操作期间，不能覆盖这个存储器。

只在安装或升级固件的过程中才会覆盖这一

存储器。

由于这个存储器芯片包含 8MB 的用户数据

(这里介绍)及 8MB 的固件存储器，因此最好

不要擦除整个芯片。在执行Erase and Sanitize

功能时，可以选择性地全面清除用户数据区域。

Bootrom 否 是 CPU 引导参数 出厂时编程 CPU 电路板

存储器 没有用户数据 在正常操作过程中，不能覆盖或擦除这个

(EEPROM) 存储器。这些只读数据在出厂时编程。

8 kB

校准数据 否 是 出厂校准 / 配置 仅用于工厂或服务 RF 电路板

(闪存) 数据备份

256 kB 没有用户数据

LCD显示屏 否 否 显示缓冲器 操作系统 RF 电路板

存储器

(RAM)

160 kB

了解存储器类型

信号发生器拥有多种存储器类型，每种类型都用来存储特定类型的数据。在删除敏感数据前，应了解怎样使

用每种存储器类型。下表描述了基本仪器及选装的基带发生器中使用的每种存储器类型。

表 10-1 基本仪器存储器

在
正

常
操

作
期

间
可
以
写
入
吗

?

在
关
机
时
是
否

保
留
数
据

?
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在安全环境中工作

了解存储器类型
存储器 用途 / 内容 数据输入方法 在仪器中的位置及备注

类型和

容量

前面板存储 否 否 前面板键盘控制器 操作系统 前面板电路板

器 (闪存) 固件

32 MB 没有用户数据

在
正

常
操

作
期

间
可
以
写
入
吗

?

在
关
机
时
是
否

保
留
数

据
?

表 10-1 基本仪器存储器 (续)

a 仅适用于模拟仪器

表 10-2 基带发生器存储器 (选件 651,652, 654)

存储器 用途 / 内容 数据输入方法 备注

类型和

容量

波形存储器 是 否 波形(包括头文件和 普通用户操作 在执行 Erase and Sanitize 功能时，

(RAM) 标识数据) 全面清除用户数据。

≤ 320 MB

永久存储器 是 是 所有用户数据 在执行 Erase and Sanitize 功能时，

(闪存) 全面清除用户数据。

512 MB

校准数据 否 是 没有用户数据

存储器

(闪存)

128 kB

在
正

常
操

作
期

间
可
以
写
入
吗

?

在
关
机
时
是
否

保
留
数
据

?
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在安全环境中工作

从存储器中删除数据 (仅适用于选件 006)
从存储器中删除数据 (仅适用于选件 006)

在从安全开发环境中移出信号发生器时，可以使用多种安全功能从仪器中删除分类的专有信息。安全功能还

拥有可以通过远程控制实现同样功能的SCPI命令(“System Subsystem (:SYSTem)”命令; 参阅SCPI命令参考指南)。

注意 信号发生器拥有多种存储器类型(参阅第 134 页表 10-1 和第 135 页表 10-2)，每种类型都用来存储特定

类型的数据。在删除敏感数据前，应了解怎样使用每种类型的存储器。

全部擦除

删除: 所有用户文件、用户平坦度校准、用户 I/Q 校准

复位: 拥有原始出厂设置值的所有表格编辑器，确保用户数据和配置不能被访问或查看

不能: 清除存储器

擦除时间: 典型值< 1 分钟，取决于文件数量

开始: 按下 File > More > Security > Erase All > Confirm Erase

注 这一功能不同于 File > Delete All Files，后者删除所有用户文件，但不复位表格编辑器。

参阅第 36 页

如需每个键的详细信息，

使用第 23 页介绍的帮助键。

参阅第 137 页

安全模式

第 137 页

下面
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在安全环境中工作

从存储器中删除数据 (仅适用于选件 006)
全部擦除和覆盖

其执行的操作与 Erase All(全部擦除)相同，此外，它会根据美国国防部(DoD)标准清除和覆盖多种存储器类

型，具体如下:

CPU 闪存 用随机字符覆盖所有可以寻址的单元，然后擦除闪存模块。其用途与芯片擦除相同。

在擦除后恢复系统文件。

开始 按下 File > More > Security > Erase and Overwrite All > Confirm Erase

全部擦除和清除

其执行的操作与 Erase and Overwrite All (全部擦除和覆盖)相同，但增加了更多的覆盖操作。在执行这一功

能后，必须手动执行下面介绍的其它清除步骤，以符合美国国防部(DoD)标准。

CPU 闪存 用随机字符覆盖所有可以寻址的单元，然后擦除闪存模块。其用途与芯片擦除相同。

在擦除后恢复系统文件。

BBG 永久存储器 (仅适用于矢量仪器) 用随机字符覆盖所有可以寻址的单元，然后擦除闪存模块。

(闪存) 其用途与芯片擦除相同。在擦除后恢复系统文件。

开始 按下 File > More > Security > Erase and Sanitize All > Confirm Sanitize

安全模式

注意 一旦激活安全模式(按下 Confirm)，那么将不能禁用安全等级或降低安全等级；在下次开机时，

将执行该安全等级的擦除操作。一旦激活安全模式，那么在重新开机前只能提高安全等级。

例如, 可以把 Erase 变成 Overwrite，但不能进行相反操作。

在重新开机后，安全等级选择结果保持不变，但安全模式没有被激活。

在仪器下次开机时，安全模式自动执行所选的 Security Level 操作。

设置电平: 按下 File > More > Security > Security Level，选择：

—  None = 出厂时预设值，不会丢失任何用户信息

—  Erase = 全部擦除

—  Overwrite = 全部擦除和覆盖

—  Sanitize = 全部擦除和清除

激活: 按下 File > More > Security > Enter Secure Mode > Confirm

软功能键变成 Secure Mode Activated。
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在安全环境中工作

从存储器中删除数据 (仅适用于选件 006)
保护不能工作的仪器安全

如果仪器不能工作，且不能使用安全功能，那么必须拔掉处理器电路板；对于矢量仪器，必须从仪器中拔掉

A4 存储器芯片。拔出这些组件后，可以选择下列处理方式中的一个:

丢弃电路板，把仪器送往维修部门。将安装新电路板，维修和校准仪器。如果仪器仍在保修期内，那么不用

支付新电路板费用。

如果还有一台仪器可以使用，把电路板安装到该仪器中，擦除存储器。然后把电路板重新安回到不能工作的

仪器中，把其送到维修部门进行维修和校准。如果发现一块或两块电路板在工作的仪器中都不能使用，那么

扔掉不能工作的电路板，在维修单中注明其导致仪器故障。如果仪器仍在保修期内，那么不用支付新电路板

费用。

如需了解怎样拔出和更换电路板，请参阅服务指南。
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在安全环境中工作

使用安全显示 (仅适用于选件 006)
使用安全显示 (仅适用于选件 006)

这一功能可以防止未经授权的人员读取仪器显示屏上的信息，通过前面板篡改当前配置。除下图所示的信息

外，显示屏会隐去，前面板各个键会被禁用。

为重新激活显示屏和前面板各个键，应重新开机。

如需每个键的详细信息,

使用第 23 页介绍的帮助键。

图 10-1 安全显示软功能键
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在安全环境中工作

使用安全显示 (仅适用于选件 006)



显示，第 142 页

信号发生器被锁住，第 142 页

RF 输出，第 143 页

— 没有 RF 输出

— 电源关断

— RF 输出上没有调制

— RF 输出功率太低

— 失真

— 在使用频谱分析仪时信号丢失

— 在使用混频器时信号丢失，第 144 页

扫描，第 146 页

— 不能关闭扫描

— 扫描似乎停滞了

— 列表扫描驻留时间不正确

— 调用的寄存器中列表扫描信息丢失

— 在列表扫描或步进扫描中幅度没有变化，第 146 页

内部存储介质数据存储，第 147 页

— 已经保存仪器状态，但寄存器为空或包含错误状态

外部存储介质数据存储，第 147

— 仪器识别外部存储介质连接，但不显示文件

预设，第 147 页

— 信号发生器不响应

— 按下预设时执行用户预设

错误信息，第 148 页

前面板测试，第 149 页

自检，第 149 页

许可，第 150 页

与安捷伦科技联系，第 151 页

— 把信号发生器返回安捷伦科技公司

11   故障排除
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显示
显示

显示屏太暗，看不清

亮度和对比度可能设成了最小值。使用第 16页“显示设置”中的示意图，找到亮度和对比度软功能键的位

置，调节其值，以便能够看清显示屏。

信号发生器被锁住

确认信号发生器没有处于远程模式(显示屏上会显示字母R指示符)。按下Local Cancel/(Esc)可以退出远程

模式，解锁前面板。

确认信号发生器没有处于本地锁定状态，这种状态会使前面板不能操作。如需与本地锁定有关的信息，请参

阅编程指南。

如果信号发生器显示屏上显示进度条，则表明正在进行某个操作。

预设信号发生器。

信号发生器重新开机。
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RF 输出
RF 输出

没有 RF输出

检查 RF ON/OFF LED (如第 3 页所示)。如果 LED 灯灭，按下 RF On/Off，以打开输出。

确保幅度设置位于信号发生器范围内。

如果仪器正在播放波形，确保标识极性和路由设置正确 (参阅“保存标识极性和路由设置”，第 83 页)。

电源关断

如果电源无法工作，那么需要维修或更换电源。如果不能维修仪器，那么把信号发生器发送到安捷伦科技服

务中心进行维修(参阅第 151 页)。

RF 输出上没有调制

同时检查 Mod On/Off LED 和<调制> Off On 软功能键，确保这两个都指示在 ON 上。另参阅第 34 页

对矢量信号发生器上的数字调制，确保内部 I/Q 调制器打开(显示 I/Q 指示符)。

如果使用外部调制源，确保外部调制源打开，并在信号发生器规定范围内工作。

RF 输出功率太低

如果显示屏的幅度区域显示OFFS指示符，那么应消除偏置: 按下Amptd > More (1 of 2) > Amptd Offset >

0 > dB。另参阅第 49 页“设置输出偏置”。

如果显示屏的幅度区域显示 REF 指示符，那么应关闭参考模式:

1. 按下 Amptd > More > Amptd Ref Off On，直到 Off 突出显示。

2. 把输出功率复位到所需的电平。

另参阅第 50 页“设置输出参考”。

如果正在与外部混频器一起使用信号发生器，参阅第 144 页。

如果正在与频谱分析仪一起使用信号发生器，参阅第 144 页。

如果脉冲调制打开，关闭 ALC，检查脉宽位于标准范围内。

失真

如果编辑并重新保存波形序列中的波形段，序列不会自动更新头文件中存储的RMS值。这会在输出信号上

导致失真。显示序列头文件信息，重新计算 RMS 值 (参阅第 78 页)。
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RF 输出
在使用频谱分析仪时信号丢失

在与没有预选功能的频谱分析仪一起使用时，反向功率的影响会导致信号发生器的RF输出产生问题。可以

使用未调整电平工作模式来解决(参阅第 47 页)。

在某些频率上，频谱分析仪在 RF 输入端口上的 LO 馈通可能会高达 +5 dBm。如果 LO 馈通和 RF 载波之间

的频率差小于ALC带宽，那么LO的反向功率可能会调制信号发生器的RF输出幅度。这种不希望得到的AM差

率等于频谱分析仪 LO 馈通信号与信号发生器 RF 载波之间的频率差。

使用其中一个未调整电平的工作模式，可以解决反向功率问题。

参阅:

“ALC OFF 模式”，第 47 页

和

“功率搜索模式”，第 48 页

在使用混频器时信号丢失

如果在用混频器执行低幅度耦合操作期间，信号发生器的RF输出上出现信号损耗，可以通过添加衰减和增

大信号发生器的 RF 输出幅度来解决此问题。

右图显示了一个配置，其中信号

发生器向混频器提供低幅度信号。

经过内部电平调整的信号发

生器 RF 输出(和 ALC 电平)是 -8

dBm。混频器使用 +10 dBm 的 LO

驱动，拥有 15 dB 的 LO 到 RF 隔离

度。得到的 -5 dBm LO 馈通进入信

号发生器的 RF 输出连接器，到达

内部检测器。

根据不同的频率，这个 LO 馈

通的大部分能量可能会进入检测器。

由于检测器只对总输入功率响应，

而不管频率是多少，这种过高的能

量会导致 ALC 降低 RF 输出。在本

例中，通过检测器的反向功率实际

上要大于 ALC 电平，这可能会导致 RF 输出上的信号丢失。

LO 电平

=+10 dBm

反向功率对 ALC 的影响

信号发生器输出控制

RF 电平
控制

ALC 电平

=-8 dBm

RF 输出

=-8 dBm
混频器

检测器测

得 -8 dBm
的ALC电平

检测器测得

-5 dBm 的

反向功率

LO 馈通

=-5 dBm

IF

LO
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RF 输出
右面的解决方案显示了类似

的配置，并在信号发生器的RF输

出和混频器的输入之间增加了一

个 10 dB 衰减器。信号发生器的

ALC电平提高到+2 dBm，通过10

dB衰减器传输，在混频器输入上

实现了要求的 -8 dBm 幅度。

与原来的配置相比，ALC电

平高出 10 dB，同时衰减器把LO

馈通(和信号发生器的RF输出)降

低了10 dB。通过使用衰减配置，

检测器测得+2 dBm的所需信号，

以及 -15 dBm 的不想要的 LO 馈

通。所需的能量与不想要的能量

之间相差17 dB，最多导致信号发

生器的RF输出电平产生0.1 dB的

偏移。

LO 电平

=+10 dBm

反向功率解决方案

信号发生器输出控制

RF 电平
控制

ALC电平 /
RF 输出

=+2 dBm

10 dB
衰减器

混频器

检测器测

得 +2 dBm
的ALC电平

检测器测得

-15 dBm 的

反向功率

LO 馈通

=-5 dBm

IF

LO

RF 输出

=-8 dBm
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扫描
扫描

不能关闭扫描

按下 Sweep > Sweep > Off。

扫描似乎停滞了

当前扫描状态在带长条形阴影的进度条中表示(参阅“配置扫描输出”，第 27页)。如果扫描似乎停滞了，检

查下述项目:

1. 按下述多个按键顺序之一打开扫描:

Sweep > Sweep > Freq

Sweep > Sweep > Amptd

Sweep > Sweep > Waveform (仅适用于矢量仪器)

2. 如果扫描处于单次模式，按下 Single Sweep 软功能键。

3. 如果扫描触发(用 Sweep Trigger 软功能键指明)没有设置为 Free Run，那么把它设置成 Free Run，

以确定是不是扫描触发丢失阻塞了扫描。

4. 如果点触发(用 Point Trigger 软功能键指明)没有设置为 Free Run，那么把它设置成 Free Run，

以确定是不是点触发丢失阻塞了扫描。

5. 把驻留时间设置成一秒，以确定驻留时间值是不是设置得太慢了或太快了，而导致看不到扫描。

6. 确保在步进扫描或列表扫描中至少设置了两个点。

列表扫描驻留时间不正确

1. 按下 Sweep > More > Configure List Sweep。

2. 检查列表扫描驻留值是否准确。

3. 如果驻留值不正确，编辑驻留值。如果驻留值正确，继续下一步。

4. 按下 More，确保 Dwell Type List Step 软功能键设置成 List。

如果选择了 Step，信号发生器使用为步进扫描(而不是列表扫描)设置的驻留时间扫描列表点。

另参阅第 27 页“配置扫描输出”。

调用的寄存器中列表扫描信息丢失

列表扫描信息没有作为仪器状态的一部分存储在仪器状态寄存器中。信号发生器只能使用当前列表扫描。可

以把列表扫描数据存储在仪器目录中(参阅“保存和调用数据”，第 37 页)。

在列表扫描或步进扫描中幅度没有变化

确认扫描类型设置成幅度(Amptd); 在扫描类型设置成频率(Freq)或波形时幅度不会变化。
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内部存储介质数据存储
内部存储介质数据存储

已经保存仪器状态，但寄存器为空或包含错误状态

如果打算使用的寄存器编号为空或包含错误的仪器状态，调用寄存器99。如果选择了大于99的寄存器编号，

信号发生器会自动在寄存器 99 中保存仪器状态。

另参阅“处理仪器状态文件”，第 38 页。

外部存储介质数据存储

仪器识别外部存储介质连接，但不显示文件

如果外部存储介质可以在其它仪器或计算机上工作，那么可能是因为它与信号发生器不兼容；使用不同的存

储棒。如需与兼容的存储介质有关的信息，请参阅信号发生器产品技术资料。

预设

信号发生器不响应

如果信号发生器对预设没有响应，那么仪器可能处于远程模式，锁住了键盘。

为退出远程模式，解锁预设键，可按下 Local Cancel/(Esc)。

按下预设时执行用户预设

这一行为源于使用向下兼容的SCPI命令。为使信号发生器返回正常使用状态，发送命令:SYST:PRESet:TYPE
NORM。

如需与 SG-1364/U SCPI 命令有关的信息，请参阅 SCPI 命令参考指南。
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错误信息
错误信息

错误信息类型

事件生成的错误类型不超过一种。例如，生成查询错误的事件不会生成设备特定错误、执行错误或命令错误。

Query Errors (-499 到 -400)表明仪器的输出队列控制功能检测到 IEEE 488.2 第 6 章中描述的消息交换协议

的问题。这类错误会在事件状态寄存器(IEEE 488.2, 第11.5.1节)中将查询错误比特置位(第2位)。这些错误与IEEE

488.2, 6.5 中描述的消息交换协议错误相对应。在这种情况下:

在不存在输出或正在进行输出时，试图从输出队列中读取数据; 或

输出队列中的数据已经丢失。

Device Specific Errors (-399到 -300, 201到 703和 800到 810) 表明设备操作没有正确完成，这可能是由于硬

件或固件异常情况导致的。这些号码还用来表示自检响应错误。这类错误会在事件状态寄存器(IEEE 488.2, 第11.

5.1 节)中将设备特定错误比特置位(第 3 位)。

SCPI没有定义正数错误的<error_message>串。正数错误表明仪器在GPIB系统内部、仪器固件或硬件、块数

据传送过程中、或校准过程中检测到错误。

Execution Errors (-299 到 -200) 表明仪器的执行控制模块检测到错误。这类错误会在事件状态寄存器(IEEE

488.2, 第 11.5.1 节)中将执行错误比特置位(第 4 位)。在这种情况下:

头文件后面的<PROGRAM DATA>单元超出合法输入范围，或与设备的功能不一致，或

由于某些设备条件，可能不正确地执行有效的程序消息

执行错误在舍入和表达式求解操作完成后报告。数字数据单元舍入不会作为执行错误报告。

Command Errors (-199到 -100)表明仪器的解析程序检测到 IEEE 488.2语法错误。这类错误会在事件状态寄

存器(IEEE 488.2, 第 11.5.1 节)中将命令错误比特置位(第 5 位)。在这种情况下:

解析程序检测到 IEEE 488.2 语法错误(收到一条违反 IEEE 488.2 标准的设备控制消息。可能的违规情况包括

数据单元违反设备监听格式，或数据类型对设备是不可接受的类型)；或

收到不能识别的头文件，包括设备特定头文件及不正确的或未实现的 IEEE 488.2 常用命令。

错误信息文件

仪器自带的光盘上提供了完整的错误信息列表。在错误信息文件中，每条错误一般包括解释信息，进一步阐

明其含义。错误信息按数字顺序列出。在同一个错误编号有多个条目时，这些信息按字母顺序列出。
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前面板测试
前面板测试

自检

自检是用以检查信号发生器不同功能的一系列内部检测。

显示当前选择检测的细节。

运行自检需要大约 5 分钟。

如果发生错误:

1. 确保所有外部电缆(包括GPIB, LAN和USB电缆)从信号

发生器上断开，然后再次执行自检。

2. 如果仍不能通过自检，那么需要维修信号发生器。如果

不能自己维修仪器，请把信号发生器送往安捷伦科技服务中

心进行维修，并详细描述自检失败及显示屏上显示的任何其

它错误信息。

参阅第 151 页“与安捷伦科技联系”。

把所有显示像素设置到选择的颜色。

如果想退回正常操作，可以按下任意键。

RF On/Off, Mod on/Off 和 More LED 闪烁

显示键盘地图。在按一个键时，地图会指明键的位置。

正确操作:

Full CCW=-10

Full CW=10

如需每个键的详细信息，

使用第 23 页介绍的帮助键。
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许可
许可

基于时间的许可停止工作

仪器的时间或日期可能已经向前复位，导致基于时间许可过期。

仪器的时间或日期可能向后复位了超过大约 25 小时，导致仪器忽略基于时间许可。

时间和日期设置细节和注意事项请参阅第 18 页。

不能加载基于时间的许可

仪器的时间或日期可能向后复位了超过大约 25 小时，导致仪器忽略基于时间许可。

时间和日期设置细节和注意事项请参阅第 18 页。
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与安捷伦科技联系
与安捷伦科技联系

下面的网址可以帮助满足测试测量需求，并提供了与安捷伦科技当地办事处有关的信息:

http://www.agilent.com/find/assist

配件或文档: http://www.agilent.com/find/mxg

新的固件版本发布: http://www.agilent.com/find/upgradeassistant.

如果无法上网，请与现场工程师联系。

注 在信件或电话沟通中，请提供信号发生器的型号和完整的序列号。有了这些信息，安捷伦科技代表可以确

   定用户设备是否在保修期内。

把信号发生器返回安捷伦科技公司

为把信号发生器返回安捷伦科技公司进行维修，请遵守以下步骤:

1. 尽可能多地收集与信号发生器问题有关的信息。

2. 拨打所在地区专用的网页上所列的电话号码(http://www.agilent.com/find/assist)。如果无法上网，

请与现场工程师联系。在介绍信号发生器信息及其情况后，可以获得相关信息，告知用户把信号发生器

送哪里进行维修。

3. 如果有的话，使用原厂包装材料装运信号发生器，或使用类似包装，以妥善地保护信号发生器。
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术语表

A

Active Entry 当前选择的、从而可以编辑的项目

或参数。

ARB 任意波形发生器

AWG 任意波形发生器; 附加白高斯噪声

B

BBG Media 基带发生器存储介质。易失性存储器，其

中放置或编辑波形文件。

BNC Connector Bayonet Neill-Concelman 连接器。用

来端接同轴电缆的一种 RF 连接器。

C

CCW 反时针

C/N 载波噪声比

CW 连续波。顺时针

D

DHCP 动态主机通信协议

Dwell Time 在步进扫描中(参阅第28页)，信号稳定、在

扫描移到下一个点之前可以进行测量的时间。

E

EVM 误差矢量幅度；某个时点上理想参考信号与测量

的信号之间的矢量误差幅度。

G

GPIB 通用接口总线。测试设备上常用的一种8位并行

总线。

H

Hardkey 仪器上带标注的按钮。

I

IF 中间频率

Int Media 内部存储介质。非易失性信号发生器存储器，

其中存储波形文件。

IP 互联网协议。以太网络中广泛使用的TCP/IP协议套

件的网络层协议。

L

LAN 局域网

LO 本振

LXI LAN 仪器扩展协议。一种基于行业标准以太网协

议的仪器平台，旨在为中小型系统提供杰出的模块化、

灵活性和性能。另参阅 http://www.lxistandard.org

P

Persistent Settings (States) 不受预设、用户预设或重新

启动影响的设置。

点到点时间 在步进扫描中(参见第 28 页)，驻留时间与

处理时间、切换时间和稳定时间之和。
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R

RMS 均方根 随时间变化的信号的有效值(在给定电阻

器中生成同等热量要求的等效DC电压)。对于正弦波，

RMS = 0.707 x 峰值。

S

Softkey 位于仪器显示屏旁边上，执行显示屏与之靠近

的区域上显示的功能。

T

TCP 传输控制协议。以太网和互联网上最常用的传输

层协议。

Terminator 表明项目结束的单位指示符

(如 Hz 或 dBm)。例如，对 100 Hz 项，Hz 是终结符。

Type-N Connector 用来连接同轴电缆的带螺纹的RF连

接器。

U

USB 通用串行总线。另参阅

http://www.usb.org
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符号
# points 软功能键, 28
# Skipped points 软功能键, 87
ΦM

指示符, 7
直流偏移, 去除, 55
硬功能键, 53
软功能键, 53, 55

数字
10 MHz OUT 连接器, 11
100Base-T LAN 电缆, 20
628, 错误, 72
8648A/B/C/D 软功能键, 19
8656B,8657A/B 软功能键, 19

A
AC power receptacle (AC 电源插座), 9
Activate Secure Display 软功能键, 16
active (激活)

项目, 153
项目区域, 7
功能区域, 25

Active High 软功能键, 99
Active Low 软功能键, 99
Add Comment To 软功能键, 38
additive (附加)白高斯噪声。参阅 AWGN
address (地址), GPIB, 19
Adjust Phase 软功能键, 26
Adjustable doublet 软功能键, 58
adjustments (调节)

I/Q, 64
正交, 125

adjustments (调节), I/Q, 125
advance (提前)波形段, 101
Advanced Settings 软功能键, 20
Agilent 销售和服务办事处, 151
ALC

保持, 83, 84
OFF 指示符, 7
关闭模式, 47
软功能键, 26, 87

AM
指示符, 7
连接器, 9
外部源, 55
硬功能键, 53
软功能键, 53

amplitude(幅度)
显示区域, 8
硬功能键, 26
调制, 53
偏置, 49
参考, 50
设置, 26

软功能键, 26-29
故障排除, 扫描, 146

AMPTD 硬功能键, 26
Amptd 软功能键, 26-29
analog modulation(模拟调制), 53
angle (角), 正交, 64
annunciators(指示符), 7
Apply to Waveform 软功能键, 87
ARB

定义, 153
双重 ARB 播放器, 68
软功能键, 68, 97, 130
波形削减, 105

ARMED 指示符, 7
arrow keys (箭头键), 24
ATTEN HOLD 指示符, 7
Atten/ALC Control 软功能键, 26
Auto (DHCP/Auto-IP) 软功能键, 20
Auto 软功能键, 47
auto-IP, 20
AUX I/O 连接器, 13
Auxiliary Software Options 软功能键, 21
AWGN

添加, 129
指示符, 7
定义, 153
双重 ARB 播放器, 130
软功能键, 132

B
backspace 硬功能键, 24
Backup All User Files to Current Directory 软功能键, 41
Bandwidth 软功能键, 132
baseband(基带), 13

对准信号, 83
削减, 105
频率偏置设置, 72
I/Q 输出连接器, 12
存储器, 68, 134
噪声, 129
噪声指示符, 7
正交调节, 125
实时 I/Q AWGN, 130, 132
软功能键, 72
加总信号, 124
波形转换成模拟, 116

Baseband Frequency Offset 软功能键, 72
BB GEN, 124
BBG, 124
BBG 存储介质, 68, 71, 153
Binary 软功能键, 35
Bk Sp 硬功能键, 24
BNC, 153
bootrom 存储器, 134
Bright Color 软功能键, 16
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brightness adjustment (亮度调节), 16
Brightness 软功能键, 16
Buffered Trig 软功能键, 99
Build New Waveform Sequence 软功能键, 74, 95
Burst Envelope 软功能键, 121
Bus 软功能键, 27

C
C/N, 153
cables (电缆), 100Base-T LAN, 20
cables, crossover,(交叉电缆), 20
Calculate 软功能键, 78
calibration data (校准数据), 134
calibration data memory (校准数据存储器), 135
Calibration Type 软功能键, 127
calibration (校准), I/Q, 127
Cancel 硬功能键, 4
carrier (载波)

带宽, 130
配置, 26
调制, 34
载波噪声比, 130

Carrier Bandwidth 软功能键, 130
carrier feedthrough (载波馈通), 64
Carrier to Noise 软功能键, 130
Catalog Type 软功能键, 35, 78
catalog, state files (目录, 状态文件), 40
ccw, 153
Channel Band 软功能键, 26
Channel Number 软功能键, 26
circular clipping (圆形削减), 109, 112
classified (分类)。参阅安全
Clear Error Queue(s)软功能键, 42
Clear Header 软功能键, 78
Clear Text 软功能键, 24
clipping (削减)

圆形, 109, 112
矩形, 110, 113
软功能键, 105

clock, sample rate (时钟, 采样速率), 13
color palette, display (调色板, 显示屏), 16
comments (增加)及编辑注释(仪器状态), 38
Config Type 软功能键, 20
Configure 软功能键

校准阵列, 44
列表扫描, 27, 29
步进阵列, 44
步进扫描, 27, 28

Connection Monitoring 软功能键, 20
connectors (连接器)

外部触发源, 102, 104
前面板, 3
后面板, 9
路由信号, 33

Continuous 软功能键, 99

continuous step sweep example (连续步进扫描示例), 32
continuous wave output (连续波输出), 26
contrast adjustment (对比度调节), 16
Constrast 软功能键, 16
Copy File 软功能键, 35
correction array 校正阵列(用户平坦度), 45

另参阅用户平坦校正
crossover cable (交叉电缆), 20
cursor (光标), 25
cw, 153
CW (no modulation)软功能键, 29

D
DAC 超出范围错误, 72
DAC 超出范围错误, 116
DAC 超出范围错误, 116
Dark Color 软功能键, 16
data (数据)

校准, 134
entry 软功能键, 24
擦除, 136
文件, 35-38
删除, 136
串行, 同步, 13
存储

注释, 增加及编辑, 38
故障排除, 147
类型, 41
使用, 35

date (日期), 设置, 18
dc offset (直流偏移), 64
dc offset, removing (去掉直流偏移), 55
DCFMΦ/DCfM Cal 软功能键, 53
Default Gateway 软功能键, 20
default settings (默认设置)

恢复, 17
恢复系统默认设置, 23

defaults, restoring (恢复默认值), 20, 127
delay (延迟), I/Q, 125
Delete Row 软功能键, 29
Delete 软功能键

All, 35
All Files In Current Directory, 41
All Regs in Seq, 38
All Segments On Int Media, 70
All Sequences, 38
All Waveforms, 74
All Waveforms 软功能键, 95
File, 35
File or Directoy, 36, 41
Item, 25, 29
Row, 25
Selected Waveform, 74, 95
Seq Reg, 38
Waveform Sequence, 95
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DETHTR 指示符, 7
Device 软功能键, 26
DHCP, 20, 153
DHCP 软功能键, 20
Diff Mode 软功能键, 125
DIGBUS 指示符, 8
digital bus (数字总线), 13
digital operation (数字操作), 67
digital signal to analog waveform (数字信号到模拟波形转换), 116
display (显示)

消隐, 139
错误信息区域, 8
概述, 3, 7
安全显示, 139
设置, 16
软功能键标注, 8
测试, 149
文本区域, 8
故障排除, 142

display memory (显示存储器), 134
Display 软功能键, 15
Display Waveform And Makers 软功能键, 87
Displayed Case 软功能键, 24
distortion, troubleshooting (失真, 故障排除), 143
DNS Server Override 软功能键, 20
DNS Server 软功能键, 20
documentation (文档), ix
Domain Name 软功能键, 20
doublet 软功能键, 58
doublet, adjustable (可以调节的偶极), 60
doublet, trigger (偶极, 触发), 60
Dual ARB (双重 ARB)

播放器, 68
软功能键, 69

dual ARB real- time noise (双重 ARB 实时噪声), 130
Dual ARB 软功能键, 130
dwell time (驻留时间), 29, 153
Dwell Type 软功能键, 29
dwell, troubleshooting (驻留, 故障排除), 146
Dynamic DNS Naming 软功能键, 20
Dynamic Hostname Services 软功能键, 20

E
Edit 软功能键

Noise RMS Override, 78
Repetitions, 95
RMS, 78
Selected Waveform Sequence, 74, 95

Editing Keys 软功能键, 24
Editing Mode 软功能键, 24
editor, table (编辑器, 表格), 25
EEPROM, 134
Enable/Disable Markers 软功能键, 74, 95
entry, active (激活项目), 153
ERR 指示符, 8

Error 硬功能键, 42
error messages (错误信息), 42

显示区域, 8
文件, 148
信息格式, 42
类型, 148

errors (错误)
DAC 超出范围, 72
DAC 超出范围, 116

Esc 硬功能键, 4
EVENT

连接器, AUX I/O, 13
连接器, BNC, 12, 82
输出抖动, 97
输出, 82

EVM, 153
EVM 误差, 64
Execute Cal 软功能键, 127
EXT CLOCK 连接器, 12
EXT REF 指示符, 7, 8
Ext 软功能键

Delay, 100
Delay Time, 100
Ext, 27
I/Q Output, 121, 122, 123
Pulase, 58
Source, 100

external (外部)
I 和 Q 信号, 124
存储介质, 41, 147
调制源, 55
触发源, 102, 104
触发, 104

External Media Not Detected 信息, 41
External 软功能键

External, 121
Input, 125
Input I Offset, 64
Input Q Offset, 64
Media File Manager, 35
Output, 125

F
factory defaults, restoring (恢复出厂默认值), 17, 20, 127
features (功能), 2
feedthrough (馈通), 64
file catalog (文件目录)。参阅数据存储
File 硬功能键, 35, 40
file headers (头文件)

创建, 78
编辑, 79
示例, 79
查看不同文件, 81

files (文件)。参阅数据
filter, interpolator (滤波器, 内插), 116
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firmware (固件)
存储器, 134
升级, 18

firmware, upgrading (固件, 升级), 151
First Mrk Point 软功能键, 87
First Sample Point 软功能键, 87
flash memory (闪速存储器), 134
flatness correction (平坦度校正)。参阅用户平坦度校正
Flatness 软功能键, 44
FM

指示符, 8
连接器, 10
消除直流偏置, 55
外部源, 55
硬功能键, 53
软功能键, 53

Free-Run 软功能键, 27, 99
Free-Run 软功能键, 58
FREQ 硬功能键, 26
Freq 软功能键, 26-29, 44
frequency (频率)

显示区域, 7
硬功能键, 5, 6, 26
调制, 53
乘法器, 51
偏置, 49
偏置, 基带, 72
偏置, 设置, 72
参考, 50
设置, 26
软功能键, 26, 26-29

front panel (前面板)
禁用键, 139
显示, 7
使用 I/Q 输入, 65
旋钮分辨率, 17
概述, 3
测试, 149

front panel memory (前面板存储器), 135
FTP 服务器, 20
FTP Server 软功能键, 20
fundamental operation (基本操作) 参阅基本操作

G
Gated 软功能键, 58, 99
gated triggering (门选通触发), 99, 102
Gaussian (高斯)。参阅 AWGN
glossary (术语表), 153
Go To Default Path 软功能键, 36, 41
Goto Row 软功能键, 25, 29, 35
GPIB

连接器, 11
定义, 153
设置, 19

GPIB Address 软功能键, 19

GPIB Setup 软功能键, 19
green LED (绿色 LED), 6
guides, content of (指南, 目录), ix

H
hardkeys (硬功能键)

定义, 153
相关帮助, 23
概述, 3
另参阅具体键

header utilities softkeys (头文件辅助工具软功能键), 78
Help 硬功能键, 4, 23
Hostname 软功能键, 20
hostname, setting (主机名称, 设置), 20

I
I 连接器, 5
I Offset 软功能键, 125
I OUT 连接器, 12
I/O Config 软功能键, 15
I/Q

调节, 125
使用前面板输入, 65, 124
调制, 121
优化, 122
后面板输出, 12
使用后面板输出, 122
信号路径, 优化, 122
信号, 对准, 83
软功能键, 64, 121-127
波形, 削减, 105

I/Q 调节, 64
I/Q 调制, 64
IF, 153
images (镜像), 64
impairments (劣化), 64
Import Waveform 软功能键, 95
Incr Setup 硬功能键, 6
information, removing from memory (从存储器中删除信息), 136
Insert 软功能键

Insert, 74
Item, 25, 29
Row, 25, 29
Waveform, 74
Waveform Sequence Contents, 74

installation guide content (安装指南目录), ix
instrument firmware, upgrading (仪器固件, 升级), 18
Instrument 软功能键

Adjustments, 15
Info, 15
Options, 21

instrument state (仪器状态)
与波形相关, 38
文件, 38, 40
寄存器。参阅数据存储
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int media (内部存储介质), 153
Int Phase Polarity 软功能键, 121
interface (接口)

GPIB, 19
LAN, 20

Internal Baseband Adjustments 软功能键, 125
internal media (内部存储介质), 41
interpolator filter (内插滤波器), 116
IP

Address 软功能键, 20
地址,设置, 20
自动, 20
定义, 153

J
jitter on EVENT output (EVENT输出上的抖动), 97

K
keys (键)

禁用, 139
前面板, 3
相关帮助, 23
数字, 3
测试, 149
另参阅具体键

knob (旋钮), 6, 17, 24

L
L 指示符, 8
LAN

连接器, 11
定义, 153
Service Setup 软功能键, 19
设置, 20
Setup 软功能键, 19

Last Mrk Point 软功能键, 87
Last 软功能键, 17
LCD 显示存储器, 134
LEDs, 6

闪烁测试, 149
前面板, 6
调制, 34

leveling, turning off (置平, 关闭), 47
licenses (许可)

管理程序, 21
服务软件, 21
Signal Studio, 21
基于时间, 18
故障排除, 150
查看, 21
波形, 21

line power (线路供电)(绿色) LED, 6
linear sweep (线性扫描), 28
list mode values (列表模式值), 30
List 软功能键, 35

list sweep (列表扫描)
参数, 30
状态信息，30
故障排除, 146
使用, 29
波形, 31

listener mode annunciator (线性模式指示符), 8
LO, 153
Load 软功能键

All From Int Media, 70
Cal Array From Step Array, 44
From Selected File, 37
Load/Store, 29, 37
Segment From Int Media, 70
Store, 70

Local 硬功能键, 4
lock up, troubleshooting (锁住, 故障排除), 142
logarithmic sweep (对数扫描), 28
LXI, 153

M
main memory (主存储器), 134
manual control, sweep (手动控制, 扫描), 33
Manual 软功能键

Config Setttings, 20
Manual, 20
Mode, 27
Point, 27

manuals, content of (手册, 目录), ix
Marker 软功能键, 87
markers (标识)

信号, 对准, 83
markers, waveform (标识, 波形), 82-97
media (存储介质)

BBG, 153
擦除, 136
内部, 153
存储棒, 41
存储器, 41
类型, 68, 134
USB, 41, 147

memory (存储器), 134
擦除上面的数据, 136

memory (存储器)。参阅存储介质
menu keys (菜单键), 4
messages, error (信息, 错误), 148
mixer, troubleshooting signal loss (混频器, 信号丢失故障排除), 144
Mod On/Off 硬功能键, 5, 34
Mode 硬功能键, 69, 130, 132
modulation (调制)

AM, 53
指示符, 8
载波信号, 34
使用外部源, 55
FM, 53
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生成, 34
I/Q, 64, 121
相位, 53
脉冲, 57
故障排除, 143

Modulator Atten 软功能键, 132
monochrome display, setting (单色显示, 设置), 16
Monochrome 软功能键, 16
MULT 指示符, 8
multiplier, using (乘法器, 使用), 51

N
Name And Store 软功能键, 95
No Retrigger 软功能键, 99
noise (噪声), 129
noise bandwidth factor(噪声带宽系数), 130
Noise 软功能键, 130
non- volatile memory (非易失性存储器), 68
Non-Volatile Segments 软功能键, 35, 78
number keys (数字键), 24
numeric keypad (数字小键盘), 3

O
OFFS 指示符, 8
offset (偏置), 64
offsets (偏置)

基带频率, 72
I/Q, 125
使用输出, 49

on/off 开关, 6
operation, basic (基本操作), 23
operation, remote (远程操作), 19
optimization (优化), I/Q, 64, 121
options (选件)

激活, 15, 21
资源, 2

Options Info 软功能键, 21
Output Blanking 软功能键, 26
output, swept (扫描输出), 27
over- range errors, DAC (超出范围错误, DAC), 116
overshoot (过冲), 116
overview, signal generator (信号发生器概况), 1

P
Page Up 硬功能键, 4
parameters, saving a waveform’s (保存波形参数), 78
path delay (路径延迟), 64
PATT TRIG IN 连接器, 13
Patt Trig In 软功能键, 100
peak- to- average power, reducing (降低峰值平均功率比), 109
performance, optimizing (优化性能), 43
persistent memory (永久存储器), 135
persistent settings (永久设置)

定义, 153
重新设置, 23

恢复默认设置, 17
Phase Ref Set 软功能键, 26
phase skew (相位偏移), 64
pixel test (像素测试), 149
Plot CDDF 软功能键, 115
Point Trigger 软功能键, 27
point- to- point time (点到点时间), 153
polarity, external trigger (极性, 外部触发), 100
polarity, marker, setting (极性, 标识, 设置), 94
power (功率)

功率计, 44, 45
开机设置, 17
降低峰值均值比, 109
插座, 9
搜索, 48
设置, 26
软功能键, 15, 17, 26-29, 47
电源, 故障排除, 143
电源开关, 6
故障排除, 143

Power 软功能键
On, 17
On/Preset, 15
Search, 47

preferences, setting (首选项设置), 15
preset (预设)

硬功能键位置, 4
设置, 17
故障排除, 147
使用, 23

Preset 软功能键
Language, 17
List, 29, 44
Preset, 17

Proceed With Reconfiguration 软功能键, 20
programming guide content (编程指南目录), ix
pulse (脉冲)

指示符, 8
特性, 59
连接器, 10
标识, 查看, 92
调制, 57
窄, 47
同步信号, 33
视频信号, 33

Pulse 硬功能键, 58
Pulse 软功能键, 33, 58
Pulse/RF Blank 软功能键, 87

Q
Q 连接器, 5
Q Offset 软功能键, 125
quadrature adjustment (正交调节), 125
quadrature angle (正交角), 64
Quadrature Angle Adjustment 软功能键, 64, 125
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queue, error (队列, 错误), 42

R
R 指示符, 8
RAM, 134, 135
Real Time I/Q Baseband AWGN 软功能键, 132
real- time noise (实时噪声), 130
Real-Time Noise 软功能键, 130
rear panel (后面板)

I/Q 输出, 122
rear panel overview (后面板概述), 9
Recall 硬功能键, 38
recall register, troubleshooting (调用寄存器, 故障排除), 146
rectangular clipping (矩形削减), 110, 113
REF 指示符, 8
REF IN 连接器, 10
Ref Oscillator Source 软功能键, 26
reference, using (参考, 使用), 50
references, content of (参考资料, 目录), ix
regrowth, spectral (频谱再生), 108
Remote Language 软功能键, 19
remote operation annunciator (远程操作指示符), 8
remote operation preferences (远程操作首选项), 19
Rename File 软功能键, 35
Rename Segment 软功能键, 70
Reset & Run 软功能键, 99
Restart on Trig 软功能键, 99
Restore 软功能键

All User Files from Current Directory, 41
LAN settings to Default Values, 20
System Settings to Default Values, 17

Return 硬功能键, 6
Reverse Power Protection 软功能键, 17
Revert to Default Cal Settings 软功能键, 127
RF

消隐
标识功能, 93
保存设置, 83

硬功能键, 5
输出

配置输出, 26
连接器, 5
故障排除, 143

RF During Power Search 软功能键, 47
RF Output 软功能键, 121, 122, 123
RFC NETBIOS Naming 软功能键, 20
ringing (振铃), 116
ripple (纹波波动), 116
RMS, 154
rotary knob (旋转的旋钮), 24
Route Connectors 软功能键, 27, 58
Rout To 软功能键, 33, 58
routing (路由)

I/Q, 64, 121
标识

ALC 保持, 84
RF 消隐, 93
保存设置, 83

RPG 测试, 149
runtime scaling (运行时幅值缩放), 118

S
S 指示符, 8
sales, Agilent offices (安捷伦科技销售办事处), 151
sample rate clock (采样速率时钟), 13
sample rate 软功能键, 97
Save 硬功能键, 38
SAVE Seq Reg 软功能键, 38
Save Setup To Header 软功能键, 78
Scale Waveform Data 软功能键, 115
scaling 软功能键, 115
SCPI

打开, 20
参考目录, ix
软功能键, 19

screen saver settings (屏保程序设置), 16
Screen Saver 软功能键, 16
search, power (功率搜索), 48
secure (安全)

显示, 139
模式, 137
软功能键, 35

security (安全), 133
Security 软功能键, 35
Segment Advance 软功能键, 99
segment advance triggering (段提前触发), 99
segments (波形段)

提前触发, 101
头文件, 78
加载, 71
软功能键, 70
存储, 加载和播放, 70

Select 硬功能键, 24
Select 软功能键

Color Palette, 16
Different Header, 78, 81
Header, 78
Reg, 38
Seq, 38
Waveform, 29

self test (自检), 149
Sequence 软功能键, 35, 78
sequences (序列)

编辑, 76
头文件, 78
标识控制, 95
播放, 77
波形, 74

serial data (串行数据)
同步, 13
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server, enabling (打开服务器), 20
service (服务)

安捷伦科技办事处, 151
指南目录, ix
请求指示符, 8

Set Marker 软功能键, 87
settings, persistent (永久设置), 153
Show 软功能键

Alpha Table, 24
Waveform Sequence, 74
Waveform Sequence Contents, 74, 95

Signal Studio, 2
Signal Studio 许可, 21
Single 软功能键, 99
Single Sweep 软功能键, 27
skew (偏移), I/Q, 125
Sockets SCPI 软功能键, 20
sockets, enabling (打开套接字), 20
softkeys (软功能键)

定义, 154
相关帮助, 23
标注区域, 8
位置, 3
另参阅具体键

source settled signal (稳定来源的信号), 33
Source Settled 软功能键, 33, 58
Span 软功能键, 47
Span Type 软功能键, 47
spectral regrowth (频谱再生), 108
spectrum analyzer (频谱分析仪), 诊断信号丢失问题, 144
Square 软功能键, 58
standby (待机)(黄色) LED, 6
State 软功能键, 35
states, persistent (永久状态), 153
step array (步进阵列)(用户平坦度), 45

另参阅用户平坦度校正
Step Dwell 软功能键, 28
Step Spacing 软功能键, 28
step sweep (步进扫描)

间隔, 28
故障排除, 146
使用, 28

Step/Knob Ratio 软功能键, 17
Storage Type 软功能键, 36, 41
Store to File 软功能键, 37
Subnet Mask 软功能键, 20
Sum 软功能键, 121
sweep (扫描)

指示符, 8
硬功能键, 27
线性扫描, 28
列出参数, 30
列出状态信息, 30
对数扫描, 28
手动控制, 33

输出连接器, 9, 33
输出信号, 33
软功能键, 27-33, 58
步进, 28
故障排除, 146
包括波形, 31

SWEEP 硬功能键, 27
Sweep 软功能键, 27-33, 58
swept output (扫描输出), 27
switch, power (电源开关), 6
SWMAN 指示符, 8
system defaults, restoring (恢复系统默认值), 17

T
T 指示符, 8
table editor (表格编辑器), 25
talker mode annunciator (发话方模式指示符), 8
TCP, 154
TCP Keep Alive 软功能键, 20
terminator (终结符), 154
test, self (自检), 149
tests, front panel (前面板测试), 149
text area (文本区域) (显示屏上)，8
text entry 软功能键, 70
time, dwell (驻留时间), 153
time, setting (设置时间), 18
time/date reference point (时间 / 日期参考点), 18
Time/Date 软功能键, 18
time- based license, troubleshooting (基于时间许可, 故障排除), 150
time- based licenses, cautions (基于时间许可, 注意), 18
Timer Trigger 软功能键, 27
Toggle 软功能键, 95
Trigger (触发)

输入连接器, 10
输出连接器, 10, 33
输出信号, 33

trigger (触发)
连接器, 10
硬功能键, 4
初始, 4

Trigger 软功能键
& Run, 99
Doublet, 58
Key, 27
Out Polarity, 27
Source, 98
Triggered, 58
Type, 98

Triggered 软功能键, 58
triggering (触发)

门选通触发, 99, 102
段提前触发, 99
软功能键, 98
波形, 98

troubleshooting (故障排除), 141
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U
UNLEVEL 指示符, 8
unleveled operation (未调整电平操作), 47
UNLOCK 指示符, 8
Unspecified 软功能键, 78
Up Directory 软功能键, 36
Update in Remote 软功能键, 16
urls, 2, 18, 21, 151
USB

连接存储介质, 41
定义, 154
设备连接器, 11
主机连接器, 3
故障排除, 147

Use Current Directory As Default Path 软功能键, 41
user (用户)

文档内容, ix
备份和恢复用户文件, 35
平坦度校正, 44
预设, 23
预设, 故障排除, 147

User 软功能键
Current Directory As Default Path, 36
Flatness, 26, 35
Faltness Corrections, 44
Span, 47
User, 17

Utility 硬功能键, 15

V
vector operation (矢量操作), 67
View Next Error Page 软功能键, 42
View Previous Error Page 软功能键, 42
volatile memory (易失性存储器), 68, 71
Volatile Segments 软功能键, 35, 78
VXI- 11, enabling (打开 VXI-11), 20
VXT- 11 SCPI 软功能键, 20

W
Waveform 软功能键

Licenses, 21
Runtime Scaling, 115
Segments, 70
Sequence, 74, 95
Utilities, 115
Waveform, 27, 29

waveforms (波形)
削减, 105
头文件, 78
从数字基带波形中, 116
在扫描中, 31
许可, 21
标识, 82, 83
存储器, 135
概述, 68

保存仪器状态, 38
幅值缩放, 114
segment 软功能键, 70
序列, 74
存储, 加载和播放, 70
触发, 98

web 服务器, 20
Web Server 软功能键, 20
WINIT 指示符, 8

Y
yellow LED (黄色 LED), 6

Z
Zoom 软功能键, 87
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